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Basic Concepts—The
Interface

Amapi’s friendly interface is so intuitive that you almost don’t
need instructions.

• Most tools are completely accessible from the screen you
don’t need to use the menus.
• Each tool is represented by an icon that tells you its function
just by looking at it.
• Simple key commands are standard and predictable throu-
ghout the program. 

Polyhedral Modeling

Amapi creates models based on the concept of Polyhedral
Modeling. According to this concept, you are able to create three
different types of objects. This is important to know because
some tools are available for use with only certain types of
objects. 

Curves 

Curves are formed of points. They can be two- or three-dimen-
sional. Some examples of curves are arcs, rectangles, polylines,
NURBS, and circles.
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Surfaces

Surfaces are formed of facets. They can be two- or three-
dimensional. Some examples of surfaces are tubes and rectangu-
lar surfaces formed of cells (facets).

Volumes

Volumes are closed surfaces. Some examples of volumes are
spheres, cubes, and pyramids.

The Drawing area
The Workbench and Grid 

In the center of an empty Amapi scene is the workbench and
grid. Your model is built on top of this workbench. Use this work-
bench and grid as a reference so you can tell if you have changed
the screen orientation. The position of the workbench and grid
tells you if you have zoomed or panned the screen, where you are
in X, Y, Z space, and the current orientation.
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Hiding the Workbench or Grid 

If you do not want the workbench or grid on the screen, open
the Amapi Control Panel by dragging the cursor off the bottom of
the screen. Choose the Hide tool and click the workbench or grid
to hide either of them. If you want either back, show them using
the Show tool.

Views and Planes 

Amapi’s X, Y, and Z axes help you keep track of your orienta-
tion and help you perform specific modifications to your models.
By knowing which axis is which, you will understand the view you
are looking at and also the current working plane. Amapi causes
the current working plane to be that orthogonal plane which is
most parallel to the screen in the current view.

The Hide tool is the gray phantom. The Show
tool is the white phantom.

This does not mean that you cannot work in
another plane. See Working Plane, page 7-10.

Displaying the Axes 

The X, Y, and Z axes appear automatically (although only two
at a time, depending on the current view) when you choose tools.
Depending on certain factors, such as an absence of geometry on
the screen, the axes might snap to the center of the workbench.
At other times, you may be able to pick an origin.
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- You can now leave the "Reference point" selection mode
(Scale fixed point, center of rotation, ...) by putting aside
the mouse at the right of the screen. This is available in fol-
lowing tools : Rotate, Scale, Symetry, Copy

Color Representation 

The color of the X, Y, and Z axes is another way that Amapi
helps you keep track of your orientation. Each axes has a unique
color, no matter which view you are in. X axis Red Y axis Green Z
axis Blue Knowing this, you can be sure you are in the top view
(and plane) if the red and blue axes are showing, in the front view
if the green and red axes are showing, and in the side view if the
green and blue axes are showing. 

Arrow Keys/Number pad rotation 

Rotate and Pan to different views and planes using the arrow
keys, Control key and number pad. For more information, see the
next section, Keyboard Shortcuts.

Keyboard Shortcuts

Arrow Keys  

Use the left, right, up, and down arrows to adjust the view incre-
mentally. By default, the rotation is based on a pivot point located
at the center of the screen. As expected, the Left Arrow shifts the
view toward the left, the Up Arrow shifts the view up, and so on.
To achieve a panning effect, use the Control Key in combination
with the arrows.

Control Key

The Control Key is used for panning the view or executing a
Tool with a duplicate of the current object.



Pan the view 

Hold the Control Key and then hit the Arrow Keys to achieve a
panning effect. If you are working on a large model or just need
some room in one direction or another, hold the Control Key and
hit one or more of the Arrow Keys to pan the view in that direction. 

Working on an automatic duplicate of the current
object

Hold the Control Key and click on a modification tool icon (In
Modeling or Assemble ToolBox) with a current object selected. The
tool will operate on a copy of the selected object which will remain
unchanged (For example, Control--click on Move Tool allows you to
make a single copy of an object and to locate it where you want)

To change the rotation pivot point, use the
Zoom Window in Amapi’s Control Panel.

Number pad Use the number pad to change your view and cur-
rent plane. Also use the number pad to zoom in and out. 

2 Front view            
3 Zoom In 
4 Left view 
5 Top view 
6 Right view 
8 Back view 
. Zoom Out

- The keyboard keys '0' and '1' have respectively been binded
by default to the 'Zoom extents" and "Zoom Window" tools, to
access faster to this very used functions

+ and - Keys

Use the + and - keys, either on the keyboard or number pad, to
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increase and decrease the accuracy of an action. The + and -
Keys can be used when you are aligning or sizing something with
the axes, defining a curve, or specifying an area susceptible to
modification. They may also be used to scroll the Catalog images
and to walk trough the displayed database for current object
selection.

Aligning or Sizing 
When one or more axis line is on the screen, use the + and

keys to increase or decrease the number of hash marks on the
axis. This increases or decreases the precision that you are allo-
wed in performing the alignment or sizing. When the Rotate tool is
selected, use the + and - Keys to increase or decrease the num-
ber of hash marks available for rotation.

Defining a Curve   

When you have just created a curve, you will see a slider icon.
When this icon is present, you can tell Amapi how many points to
use to define the curve. Use the + and - Keys to increase and
decrease the number of points.
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Tuning tool parameters 
Some of the Modeling Tools (such as the Smooth tool, in this

example) allow to define parameters of the object. Use the + and
Keys to increase or decrease the tools’s current parameter. 

Current object selection
When several shapes overlap, use + and - keys to successive-

ley select the current object from all the shapes displayed on the
screen. 

Return Key 

Use the Return Key to enter numerical data when creating
models or to signify the end of an action. 

Enter Numerical data 
Whenever you type information about an object into the data
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box, hit the return key to enter that information.

This is called Validating.

Generally, the data boxes reveal the numerical
information that you could specify through

mouse clicks.

Signify the end of an action
Some tools require multiple mouse clicks (like Polylines,

NURBS curves, and extrusions). Hit the Return Key to tell Amapi
you are done placing points for that object.

Tab Key

Use the Tab Key to access data boxes that appear at the lower
left corner of the screen. A data box may appear when you are
selecting, constructing, modifying, or assembling objects. 

Naming Objects 
When you have no tool selected, hit the Tab Key to type a

name for the current object. Hit return to validate.

Constructing, Modifying, or Assembling Objects 
When you choose almost any of the Construction, Modeling, or

Assembly Tools, you will see a data box in the lower left corner of
the screen. Hit the Tab Key to type a location, size, or other nume-
rical information about the object.

1-10



Shift Key 

If you want to create a point on a new object that is in the same
location as a point on an existing object, use the Shift Key. If you
hold the Shift Key and move the cursor around, the cursor will
snap to the nearest point. The Shift Key also allows you to select
additional objects with the wand cursor.

If you select multiple objects in this way, they
will be grouped together. Ungroup them, if

necessary, with the Control Panel’s Ungroup
tool.

Space Bar

The Space Bar has many toggling effects. Sometimes it will
lock onto one axis to limit your modifications, or it might contain a
tool-specific command. 

Locking onto one axis 
There are several instances where you have the opportunity to

hit the space bar in order to lock onto one axis or another. This is
helpful when moving objects, extruding in one direction only, and
when creating aligned duplicates.
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1. If you want to lock onto an axis, hit the space bar.
Only the horizontal axis shows and you must keep the cursor
on this axis. 

2. Hit the space bar again.
Now you are locked onto the vertical axis. 

3. Hit the space bar again.
Now you may align on both axes again. 

Specialty Commands 

Sometimes you will use the space bar for a tool-specific varia-
tion. The Duplicate or the Sweep tools, for instance, will offer dif-
ferent model orientations if you hit the space bar.

Option Key

The Option Key allows you to access sub-tools that are avai-
lable with the currently selected tool. When the Wand cursor is
showing, and frequently with other tools, the selection tools
(Lasso and Bull’s-eye) can be accessed using the Option Key.
Sometimes, as in the Measurement tool, additional tools are
accessible through the Option Key. The option-click will always
reveal each possible tool and then start over from the beginning.

Delete Key

Hit the Delete Key at any time to undo your last action when
you  are inside a tool. For many tools, you can undo several steps
by hitting the Delete Key as long as you are inside the tool. After
the tool is put-aside, hitting the Delete Key will also delete the
currently selected object(s).

Selecting Objects

When you have no tool selected, the cursor is a Wand icon.
This cursor has a number of uses for selecting different screen
objects. One object on the screen is always selected. Selecting
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objects will become important to you because most tools work
only on the currently selected object or selected points.

However, it is possible to change the current object inside the
following tools :

. Move

. Stretch

. Rotate

. Scale

. Snap

To do that, when you are using one of these tools, press the
ESC key. The magic wand appears. Click the object you want to
be the current one (Put-aside on the right of the screen to
Cancel). You can continue to use the current tool on the new
selected shape.

Accessing the Cursors 

By default, the Wand cursor is always what you see when you do
not have another tool chosen. If you hold the Option Key and click the
mouse button, you see an arrow icon. This is the Lasso cursor. It is
used to surround a group of points for selection. Option-click again and
you see a Bull’s-eye cursor. This is used to choose individual points for
selection. Option-click again and you are back to the Wand cursor. 

The Cursors

• Wand : 
Use this cursor to select an entire object. Click anywhere on
the object you want selected. The selected object is distingui-
shed by its cyan color and its center of geometry. The center of
geometry is marked on the selected object with a small white
sphere.
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• Lasso : 
Use this cursor to surround a number of points, facets, or
lines on the currently selected object. A selection like this will
allow you to work on only part of the object. The selected
points and lines are highlighted on the screen.

The Lasso cursor will only select points and
lines on the current (clicked with the Wand)

object.
To surround part of an object with the Lasso:

1. Click points to form a ring around the part you
want to select.

2. When everything you want is surrounded by the
Lasso, hit Return. 
The points are now selected. 
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• Bull’s-eye : 
Use this cursor to select one point or several individual points.
This works well if you need to isolate certain points that are
spread out and therefore won’t work with the Lasso cursor. 

1. With the Bull’s-eye cursor, click points you want
selected. 
Each point you click is highlighted. To deselect a point, just
click it again.

2. When you have clicked every point that you
want, hit Return. 
The points you clicked are now selected and you can use one
of the other tools to edit them. 

The Toolboxes

There are five different toolboxes you use when creating a
model in Amapi. They each have a set of tools that make desi-
gning simple. 

Accessing the Toolboxes 

The three creation toolboxes are located at the right side of
the Amapi screen. To switch from one Toolbox to another, simply
sweep the cursor off the right side of the screen. We call swee-
ping the cursor off the right side of the screen “put-aside” or “put-
ting-aside.” This is because when you put a tool away (put it
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aside), you drag off the right side of the screen, just as you do
when toggling toolboxes. When you open Amapi, the Construction
Toolbox appears on the screen automatically. Put aside the cursor,
and the Modeling Toolbox appears. Put-aside the cursor again and
the Assembly Toolbox appears. 

As you put-aside the cursor to reveal the tool-
boxes, this is the order they always appear:

Construction, Modeling, Assembly,
Construction again...

The Toolboxes 

• Construction Toolbox
This Toolbox contains tools for the creation of
primitives. Tools here will create 2D shapes
like arcs and rectangles and 3D shapes like
spheres, cubes, and extruded forms. See
Chapter 4 for more information.

• Modeling Toolbox
This Toolbox contains tools for editing primitives.
First create a primitive with the Construction
Tools and then modify it with the Modeling Tools.
Some modifications you can make are stret-
ching, scaling, smoothing and adding fillets. See
Chapter 5 for more information.

• Assembly Toolbox
This Toolbox contains tools for changing the
orientation of screen elements. By the time
you use the Assembly Tools, you have crea-

ted a model with the Construction Tools and probably modified
it with the Modeling Tools. Some modifications you can make
using the Assembly Tools are rotating, welding, and duplica-
ting. See Chapter 6 for more information.
Along with the three creation toolboxes, Amapi offers two more
toolboxes that allow you to view and access your work more
easily. They are the Control Panel and the Catalog. 
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• Render and Animation Toolbox
When any of the three previous toolbox is disp-
played, pressing the Space Bar reveals the
Render and Animation Toolbox. Space Bar is a
toggle since pressing again on it will come
back to the previous modeling toolbox dis-

played. This toolbox contains Rendering and Animation tools,
accesible through the Render and Animation menus. See Chapters
9 and 10 for more information.

• The Control Panel 
Amapi offers another toolbox that you access almost like the
three creation toolboxes. If you drag the cursor on the bottom-
right of the screen icon, you reveal the Control Panel. The
Control Panel allows you to change the way you view your
model. Some of the tools available here let you group and
ungroup, hide and show, zoom, and paint. To release the
Control Panel, put it aside by dragging the cursor off the right
side of the screen. See Chapter 7 for more information.

• The Catalog
At the bottom of each of the creation toolboxes is the icon for
the Catalog. The Catalog is a toolbox in itself Use the Catalog
to store, retrieve, or delete models, and to import and export
files. See Chapter 2 for more information.

Releasing Tools

There are a couple of ways to release tools when you are done
using them. The method of releasing the tool depends on how the
tool is used.

Validate

A tool which requires a number of mouse clicks to define the
shape is released when you hit the Return Key. Tools such as
Polyline and NURBS curves can be created with two mouse clicks

1-17



or twenty. The Return Key tells Amapi that you are done choosing
points. When you hit the Return Key to release a tool or end an
action, it is called Validating. You may also have to put-aside a
tool after validating. 

Put-Aside 

A tool which requires a specific number of mouse clicks to
define the shape is released when you sweep the cursor off the
right side of the screen. This is called putting-aside. A circle, for
example, is created with only two mouse clicks. Each of these
tools is released by putting it aside.

Creating Forms

Many of the tools create or modify an object by: 
1. choosing points through mouse clicks or 
2. typing values for the location of points or 
3. using a combination of typing and clicking points. 

To create a form by clicking points with the mouse: 

After you choose a tool, simply click points where you want
them to be located. Notice the dialog box at the lower left corner
of the screen. This gives you information regarding the point you
will be creating when you click the mouse

To create a form by typing values in the data box:

In most cases, when you choose a tool, a data box appears at
the bottom left corner of the screen. This allows you to type in
specific values for the location of points on your drawing.

Select Absolute Mode from Edit menu to have any coordinate
indicating the absolute location in space (origin is the center of
the Workbench). Unselect Absolute Mode from Edit menu if you
want to have any coordinate indicating the relative location of the
cursor from the previous clicked point (this is the default).

1 2

3

4
1 2

3

4

5

1 2

3

4

5

6
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1. Hit the Tab Key to activate the data box.

2. Type in a value
If there is more than one value field available, you can toggle
between them by pressing the Tab Key.

3. When the data box holds the value you want,
hit Return to see the effect on the drawing.

To use a combination of typing and clicking:

You may want to use a combination of typing and clicking.
Perhaps you will hit the Tab Key and type in a specific value for

the object’s starting point and then click the mouse to indicate
the object’s second point.

Defining Curves

When drawing a curved shape, you may specify how many
points you want used in defining the curve. Upon completion of
the curve, a +/- slider icon appears.

This icon allows you to choose the number of
points you want defining the curve. This informa-

tion can be input in one of two ways:

1. Use the + and - Keys on the number pad
to increase or decrease the number of
points.
Move the cursor off the right side of the screen to put-
aside the tool.

OR

2. Hit the Tab Key and type in the number of
points you want defining the curve.
Hitting Return changes the number of points and releases the
current tool.
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The more points used, the smoother the
curve. Initially, you may want to keep the

shapes in a rough form and use the Smooth
Tool later as a finishing touch. Shapes formed

of fewer points will redraw more quickly.

Canceling Actions, Undoing, and
Erasing

If you catch the mistake in time, nearly every action is rever-
sible. For many tools, like Polyline and NURBS curves, you can
undo several steps with the Undo command in the Edit menu. You
can also Undo an operation by using the customary Macintosh
keyboard shortcut, Command-Z. 

In Amapi, hitting the Delete Key will also undo the last step(s)
if you haven’t put-aside the tool. After you have released a tool,
you have the opportunity to Undo-Redo several steps of modifica-
tions. The number of these steps is defined by the corresponding
setting value in Amapi preferences dialog.

Even if Amapi was specially optimized to be
smallest memory consuming to keep informa-

tions for cancelling the previous operations,
some tools (like cutting operations for

example) takes memory to be cancellable. So
adjust the number of Undo steps available in
the Amapi preferences dialog (Edit menu) in
accordance to the system memory available

for Amapi.

Erasing the screen or part of it 

To erase the screen and save nothing 

1. Click the bottom icon on any creation tool
palette.
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This will display the Catalog. The Catalog is Amapi’s built-in file mana-
gement system. At the left side of the Catalog is the Black Hole. 

2. Click the Black Hole.
Everything on the screen disappears. If you click the Black
Hole by accident, hit Command-Z or choose Undo from the Edit
menu to bring it all back. If you are working on an existing file,
only the objects are deleted but the filename still exists as can
be seen in the title bar. To delete the entire file, you need to
drag the contents from the Catalog into the Black Hole. 

3. Sweep the cursor off the right side of the
screen. 

This is the way you release any tool you are using in Amapi.

To erase one or more objects on the screen

1. Display the Control Panel

2. Click the Disintegrator Gun icon.
This is, officially, the Delete Entity tool. It acts just as you
might expect a Disintegrator Gun to act.

3. Point the Delete Entity tool at the object you
want to erase and click the mouse button. 
Be aware that this tool deletes the object closest to it. If you
accidentally deleted something you need, hit Command-Z or
choose Undo from the Edit menu.

4. Put-aside the cursor.

To move to a new location on the screen
If you do not want to erase the objects on the screen but want
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a new area to work in, try panning the screen.

1. Hold the Control Key.

2. Hit any of the keyboard arrows.
You will, of course, want to use the arrow that will take you in
the direction you want to pan. If you use these arrows without
the Control Key, the view will rotate in 3D space around the
center point of the screen.

3. Start creating in your new open work space.

To locate the objects you have panned away
from, sweep off the bottom of the screen to

display the Control Panel. Click Zoom Extents
to display all objects.

To save the image and clear the screen

1. Click the bottomost tool on any creation tool
palette.

This displays the Catalog.

2. If necessary, click the scroll arrows to display
an empty box in the Catalog. 
Amapi is packaged with an assortment of sample files. These
files appear in the Catalog. If you click on an occupied box, a
thumbnail sketch of the drawing appears and you may place it
in your drawing.

3. Click on an empty box.
A tiny representation of the current screen image appears in
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the box.

4. Type a name for the saved image and hit
Return. 
This is now saved as an actual file in the Amapi folder. To do
the same action, use Save or Save as... from the File menu.

5. To erase the screen, click the Black Hole at the
far left of the Catalog.
The scene disappears from the screen, but it is saved in the
Catalog. 

Extended drawing constraints

When you are working on the graduated rulers, it is possible to
define constraints for attracting the cursor interactively.

The cursor may be attracted :
• to existing points or segments
• to the horizontal and vertical lines passing through a point
• to a line parallel or perpendicular to 2 points.
• to the intersection of these constraint lines.

The following commands are used :
• The Shift key to start constrained drawing mode
• The combination of Control and Shift key to define points of

constraint.

By default and if the corresponding preference has been acti-
vated, attraction to both points and segment is available. This
means that during your drawing, the cursor will be attracted by the
nearest point or segment by holding the Shift key, as well as by
the horizontal and vertical lines passing through the current origin
of the ruler (This origin becomes automatically a point of
constraint).

To define a second and third point of constraint, hold both
Control and Shift keys and click on the required point.
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Then move with the mouse whithout releasing the Shift key.
Your position in relation to the points of constraint is displayed on
the bottom right-hand-side of the screen.

perpendicular parallel

intersection horizontal alignment

vertical alignment

For example, if you have selected a point of constraint and the
position of the cursor forms a right-angle with the straight line
from the origin of the ruler to the point of constraint, a right-angle
icon is displayed and the movement of the cursor is constrained
to this perpendicular (but not blocked).

When you release the Shift key, the attraction is deactivated
and the points of constraint disappear.

Selection of a point of constraint The cursor is attracted
using Shift+Click to the vertical from

this point

Attraction and constraint Combination of perpen-
perpendicular to the last dicular and vertical
segment attraction
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The Catalog

The Catalog is Amapi’s built-in file management system. It
allows you to store libraries of images for easy access. The
Catalog gives you a visual link to all the Amapi files you have
saved on your hard drive. With the Catalog, you don’t need to use
the open or save commands, although you certainly can if you
want. It is very easy and fast to pick a file from the Catalog and
bring it into your work space. The Catalog also supplies buttons
for importing and exporting documents and erasing screen ele-
ments.

The Catalog is accessible at any time by clicking the bottom
icon of any of the three creation tool palettes.

The Catalog appears across the top of the screen. You have 5
possible actions : use the Black Hole to erase something from the
screen, place an image from the catalog into the current scene,
place an image from the scene into the catalog, import, or export.
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The Black Hole

The icon on the left side of the Catalog is the Black Hole. Use
this icon to erase catalog items or items from the current scene. 

Erasing a Catalog image 

Erasing a Catalog image is essentially the same as throwing
that particular file in the trash from the desktop. This action can-
not be undone, so be sure you want the image destroyed. 

1. Click the image in the Catalog you want to
erase permanently. 
A small version of it appears as you move the cursor around. 

2. Click the Black Hole. 
The image is gone. 

Erasing part of the scene 

Erase one or more elements from the current scene by drag-
ging them into the Black Hole. This action cannot be undone, so
be sure you want the image destroyed. If, however, you saved the
drawing before placing the item in the Black Hole, you can retrieve
the deleted item it by closing the file without saving. 

1. Click the object with the Wand cursor in the
scene you want to erase permanently.

A small version of it appears as you move the cursor around. 

2. Click the Black Hole. 
The image is gone. 
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Erasing the entire scene 

If you want to erase everything from the current scene and
start over, this is the way to do it. However, as you can see the
file is not erased, only the contents are. To start over in a new
file, choose New from the File menu. 

1. Do not click any of the screen elements.
The cursor should be the Wand.

2. Click the Black Hole. 
Everything is gone! If you make a mistake and need to bring
your geometry back, choose Undo (or Command-Z) from the
Edit menu. 

Copy an image from the Catalog

A common use for the Catalog is to place a copy of an image
from the Catalog into your current scene. 

Browsing the Catalog

Amapi allows a number of ways for you to browse the Catalog.
Use the scroll slider, + and - keys, or type a page number.

Scroll Slider

The Catalog has a page browser that you can use to browse
the catalog images. Drag the slider to replace the entire line
of ten with the previous or next ten images.

+ and - Keys

Use the + and - Keys to scroll the Catalog images. These keys
work just like the scroll arrows. 
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Erasing the screen in this manner also returns
the default view. For example, if you had zoo-

med in before clicking the black hole, the view
is zoomed out again after you click the Black

Hole.

Typing a page number

Each page in the Catalog is numbered. When the Catalog is
chosen, a data box appears. You can hit the Tab Key and type a
page number you want to see. Hit Return to go to that page.

Copy an image from the Catalog

1. Use the scroll arrows (or any browsing method),
if necessary, to locate a scene in the catalog that
you want to place in your drawing.

2. Click the image you want. 
A small version of it appears as you move the cursor around.
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3. Click the scene to place the
image. 
This places a copy of the image into your
current file. You can also use the Merge...
command in the File menu to insert the geo-
metry into the current drawing. 

To work directly with the image and not with
a copy, you will need to Open the file from

the File menu.

4. Use any of the tools to modify the form. 

Define the Catalog 

The Catalog always displays the files that are saved in the cur-
rent work directory. To choose the current folder, follow these
steps:

1. Choose Define Catalog ... from the File menu. 
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2. Open the folder whose contents you want to
appear in the Catalog. 
Once the folder is open, the list of Amapi files contained in
this folder appears

3. Double-click on a file name to specify the
shown folder for the Catalog folder
The dialog box is dismissed and the files contained in this fol-
der are now displayed in the Catalog. 

Amapi uses a file named CAT.LIST to deter-
mine which file is present in the Catalog and

the place where it is located. If no file
CAT.LIST exists in the open folder (you may

have moved some files from a folder to ano-
ther using the system file management), no

icons will appear in the catalog. To fill it with
all files contained in the selected folder, click

rebuild (you may access to the rebuild com-
mand through the utility icon -right corner of

the catalog-). 

To exit the dialog box without changing the
Catalog folder, click Cancel.

To rename a Catalog entry later, click in the
area where the name is displayed. Type the

new name and hit Return.

Save a model to the Catalog

The following steps will save the entire scene as one Catalog
entry.

1. Use the scroll arrows, if necessary, to locate an
empty box in the Catalog.

2. Click one of the empty boxes. 
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The current scene appears in the box. 

3. Type a name for the scene and hit Return to
enter it. 
If you don’t give it a name, it is automatically called “Surf”
plus a number to identify it.

If you want to save 3 of 5 objects in one
Catalog entry, first group those objects and

then drag them into the Catalog 

The following steps will save a selected object as one Catalog
entry.

1. Click the object you want to save in the
Catalog.
A small version of it appears as you move around the cursor.

2. Click an empty box in the Catalog.
The selected object appears in the box.

3. Type a name for the scene and hit Return to
enter it.
If you don’t give it a name, it is automatically called “Surf”
plus a number to identify it.

Replace a Catalog entry 

If you have stored your scene in the Catalog and then make
changes, you may want to replace the Catalog image with the cur-
rent screen image. 

1. Scroll to the Catalog image you want to
replace. 

2. Before clicking on any image, hit the Return
Key.
The cursor shows a small preview of the current screen. 
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3. Click the Catalog image you want to replace.

The new image replaces the old.

Rearranging Catalog Items 

You can change the order of drawings in the Catalog just by
dragging them to new locations within the Catalog. 

1. Click the Catalog image you want to move.
A small version of it appears as you move the cursor around. 

2. Click an empty box to place the scene in the
new location.

Import

This command imports a document. An import icon is available (in
addition to the Import command in the File Menu) when you choose
the Catalog from any Toolbox. The Import button displays a pull-down
menu when you click it. This menu allows you to choose what type of
file you want to import : Amapi, DXF, Illustrator 3, 3DMF (on
Macintosh), VRML, 3D Studio, or IGES.

To import a file

1. Click the Catalog’s Import icon (or choose
Import from the File menu).
In either case, a submenu of File Types appears.

2. Click the File Type you want to import. 
An import dialog box appears, allowing you to choose a docu-
ment to import. Only documents of the File Type you specified
are available. 
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Export

This command saves the current document in a different for-
mat. An export icon is available (in addition to the Export com-
mand in the File menu) when you choose the Catalog from any
Toolbox. The Export button displays a pull-down menu when you
click it. This menu allows you to choose a type of format for the
exported file. You can export the file in these formats : Amapi 2.x
(for versions of Amapi prior to the 3.0 version), DXF, IGES, STL,
3DGF, CadRender, RIB, RayDream Designer, KPT Bryce (available
for the «pro» version), 3D Studio, 3DMF (For Mac version only),
FACT, Illustrator 3.0, PovRay, Strata Studio Pro (Mac only), VRML,
TrueSpace and Lightwave.

To export a file 

1. Click the Catalog’s Export icon (or choose
Export from the File Menu).
In either case, a submenu of File Types appears. 

2. Click the File Type you want to export the cur-
rent Amapi document as. 
An export dialog box appears, allowing you to name the docu-
ment and choose a location to store the exported file. 

3. Type a name and choose a location for the
exported file. 
Amapi will add an appropriate extension, depending on the for-
mat you choose for the export.
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In the right corner of the Catalog, you will find 3 utilities icons.

Change Directory
By Holding the mouse button on this icon, you will get a menu,
allowing you to change the Catalog Directory. The displayed list
shows you the sub-directory of the current Catalog directory,
as well as the bookmarks list.

Set Bookmark
If you want to keep the current Catalog directory as a book-
mark, hold down the mouse button on this icon, then release it
on the «Bookmark N» item. The current folder will be recorded
as a bookmark, and will be displayed in the Change Directory
menu, allowing you to go directly to this directory in a future
session of work.

Utilities
This icon let you access to several utilities :

Toggle Directory: Allows you to change the current Catalog
directory, as well as the Define Catalog menu command. 
Rebuild Catalog: Creates a new catalog from scratch,
which becomes updated according to the contents of the
selected directory, as well as to Re-create the correspon-
ding previews. This could allow you for example to import a
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whole project from an other system (Mac, PC or Unix works-
tation), as well as to update a folder in which you have
added files.
Verify Catalog: Removes from the catalog the scenes they
are not on the disk, and adds into the catalog the scenes
directly added on the current directory (like Rebuild, but
without recreating the previews).

Catalog Preferences: Access to the network settings for
remote communications (See Chapter 2 - Network
Preferences). 
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The File and Edit Menus
The File and Edit Menus offer many of the same file manage-

ment and editing options as other applications, but Amapi has
added functionality to these too!

The File Menu

New (

 

� N) 

This command in the File Menu creates a new Amapi docu-
ment. The new document has no name (the title bar shows
“Untitled”). You may have several documents open at a time.

Open... (� O) 

This command in the File Menu opens an existing document.
The Open dialog box offers options to narrow your search area.
You may choose to open a document in Amapi format (default
choice), DXF, IGES, EPSF or PICT format. The All option lets you
choose from any of these formats. The dialog box also displays a
thumbnail preview window so you can see what you are opening.

Opening a document 

1. Choose Open... from the File Menu. 
The dialog box appears. 

2. Open the appropriate folder. 

3. Click the file name you want to open. 

4. Click the Open button. 

Merge... (� M)

This command in the File Menu opens an existing document
and places the form(s) it contains into the current drawing. When
you choose Merge..., the Open dialog box appears. It offers
options to narrow your search area. You may choose to merge a
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document in Amapi format (default choice), DXF, IGES, EPSF or
PICT format. The All choice lets you choose from any of these for-
mats. The dialog box also displays a thumbnail preview window so
you can see what you are merging. 

Merging Documents 

1. Choose Merge... from the File Menu.

2. When the dialog box appears, choose the for-
mat you want.

3. Open the appropriate folder.

4. Click the file name. 
Verify through its thumbnail preview that it is the correct docu-
ment. 

5. Click the Open button. 

6. The drawing is merged (added to the existing
geometry) with the current drawing. 

Close (� W)

This command in the File Menu closes the current Amapi docu-
ment. You are asked if you want to save changes to the current
drawing. If you have unsaved changes that you want to keep, click
the Yes button. If you want to close without saving changes, click
the No button. If no documents are still open, Amapi remains
open, ready for you to open or start a new document.

Save (� S) 

This command in the File Menu saves the current Amapi docu-
ment. If you have saved the document previously, it is updated
and saved in the same location as it was saved before. If you
want to save it to a different location or with a different name,
choose Save As.... If you choose Save and the document has not
been saved previously, the Save As... dialog box appears automa-
tically, allowing you to name the document and specify the loca-
tion in which to save it.
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Note: You should save frequently or use Amapi’s Autosave
function. 

Even though your drawing appears on the screen, it is not sto-
red on the disk until you save it. Hours of work can be lost
because of a power failure. It is also important to save before per-
forming any intricate, multi-step maneuvers. In that way, if the
result is not exactly what you had hoped, you can return to where
you were before the operation by closing the document without
saving.

You can also close the document by clicking
the close box at the upper left corner of the

title bar.

Use the Preferences command in the Edit
menu to turn on Autosave. At time intervals

you specify, Amapi will save the current
document to disk.

Save As... (� E)

This command in the File menu saves the current document. A
dialog box appears so you can name the current document, give it
a different name, or save it to a different folder. 

1. Choose Save As... from the File Menu. 
The dialog box appears. 

2. If necessary, display a different folder. 

3. Type the name you want to use in the File name
box. 

4. Either press Return or click Save. 

Making a backup 
You should make a backup of your work in case you make

many changes and want to go back to the original version. You
can use the Save As... command in the File Menu and save the
file with another name. If you wish to save the hidden objects in
the file, use Save or Save As... from the File Menu. 
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System Crash Backup File 
Under situations when you run out of memory which results in

a System Crash, Amapi creates a crash backup file called
AMBackup in the current Catalog folder. In case, the current
Catalog folder is not set, the file is created in the same folder as
the Amapi Program (Amapi 2.0 Folder). It is recommended that
you launch this Amapi document just like any other modeler file
and use Save As... to save the file under a different filename.
This is to ensure that in case of future crashes, the AMBackup
file is not overwritten.

Define Catalog... (� K) 

Amapi’s catalog system allows you to save forms that you can
open quickly for use in your designs (the catalog is accessed
through the bottom tool on all of the tool palettes—for more infor-
mation, see The Catalog, chapter 2). The Define Catalog com-
mand in the File Menu allows you to choose which forms appear
in the Catalog. You may want to save forms into different folders.
This way, the Catalog will contain only the forms that you need at
that time, eliminating the need to scroll through a long list. In
order to change the catalog by using Define Catalog..., you need
more than one folder containing Amapi documents. 

Define the Catalog 
The Catalog always displays the files that are saved in the cur-

rent work directory. To choose the current folder, follow these
steps: 

1. Choose Define Catalog... from the File Menu. 

2. Open the folder whose contents you want to
appear in the Catalog. 
Once the folder is open, the list of Amapi files contained in
this folder appears.

3. Double-click on a file name to specify the
shown folder for the Catalog folder
The dialog box is dismissed and the files contained in this fol-
der are now displayed in the Catalog. 
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When you have the Catalog open, you can
access the Define Catalog... dialog box by hit-

ting the space bar.

To exit the dialog box without changing the
Catalog folder, click Cancel.

Import

See Import in the Catalog—Chapter 2.

Export

See Export in the Catalog—Chapter 2.

Page Setup

If you do not have a printer driver installed in
your System’s Extensions folder, nothing hap-

pens when you choose the page Setup or Print
commands.

Use Page Setup to give specifications to the document in pre-
paration for printing. Depending on the type of printer you have,
you will see a dialog box asking such typical questions as the
page orientation and paper size.

Print (� P)

Print will print the current scene to your printer. 

Not only can you choose Print or use the cmd-
P keyboard shortcut; you can also click the

Printer icon in the Control Panel.

1 Choose Print from the File Menu. 
A print settings dialog appears.

2. Set the parameters you want to use for printing
and hit OK when ready to continue.
A rectangular page icon representing the page appears.

3-7



3. Hit the space bar to toggle between landscape
and portrait orientation. 
Place the center of the page over the center of the geometry
you want to print.

4. Click the mouse button when the center is loca-
ted. 
Move the cursor to expand the size of the page.

5. Click when the geometry you want to include is
within the page boundaries. 
The geometry you include on the page is sized to fit within the
page boundaries.

6. If you are using the Printer driver, the system
printing dialog box brings up.
Depending on the type of printer you have, you are able to spe-
cify printer settings, or cancel printing.

Quit (� Q)

This command in the File Menu closes Amapi. You will be
asked if you want to save changes before quitting.

1. Click yes to save and quit.

2. Click no to not save and quit.

3. Click cancel to not save and not quit.

The Edit Menu

Undo (� Z)

This command in the Edit menu reverses the last action. While
using some tools, you can undo many times in a row. The number
of times possible after putting aside the current tool depends on
the number of Undo levels you have specified in preferences. In
Amapi, hitting the Delete key has the same effect as choosing
Undo from the Edit menu when you are inside the tool.
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Redo (� R)

This command in the Edit menu reverses the last Undo. E.g. if
you cancel the last operation, you may return to the original situa-
tion, re-doing the action you have cancelled. 

Cut (� X)

This command in the Edit menu removes the selected objects
and places them on the Clipboard. Each selection you cut or copy
to the Clipboard replaces the previous Clipboard contents.

Cutting objects

1. Select the object to be cut.
Click it with the Wand; the selected object is colored cyan and
displays its center of geometry as a white sphere.

2. Choose Cut from the Edit menu.
Once you cut a selection, you can paste it. In Amapi, a cut
object is pasted exactly in the position it was cut. You can use
Cut and Paste to create duplicate geometry in the current
document or from one document to another. You can even
paste the cut selection into a document in a different applica-
tion.

Copy (� C)

This command in the Edit Menu places a copy of the selected
object onto the Clipboard without deleting the original. You can
paste the copy elsewhere in the current document or into a diffe-
rent document. You can even paste the copied selection into a
document created with a different application. Many of the illustra-
tions in this manual were copied from Amapi and pasted into a
word processing document.

Paste (� V) 

This command in the Edit Menu pastes a copy of the Clipboard
contents onto the center of the drawing area, on top of other geo-
metry. The Clipboard contents are not changed when you use the
Paste command. You can also paste the selection into another
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document or into a document created with another application.

Delete 

This command in the Edit Menu deletes the currently selected
object. The object is not saved to the Clipboard.

Select All (� A)

This command in the Edit Menu selects all objects that are
visible on the Amapi screen. 

When you choose Select All the objects will be
grouped together.

Windows

This command in the Edit menu gives the list of open windows.
To select one of them as the current drawing, pull the cursor down
to its name and release the mouse button

Absolute Mode

This command in the Edit menu allows you to activate or deac-
tivate Absolute mode for display and input of (X,Y,Z) locations. By
default, this option is deactivated, so all the given coordinates are
relative to the last point entered. If you activate this mode, all the
coordinates values will be displayed and input as absolute posi-
tions from Amapi World Center, which is located in the middle of
the WorkBench.

Redraw (� T) 

This command in the Edit menu redraws the entire screen, flu-
shing away eventual remanent drawings and cleaning objects
appearance.

Preferences... (� ;) 

Amapi allows you to set preferences so that you can customize
your copy of Amapi to suit your needs. Mac (only for Macintosh
and PowerMacintosh versions), Unit, Amapi, EPSF import, and DXF
import / export settings can be customize.
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Setting Preferences 

1. Choose Preferences from the Edit Menu. 
A pull-down menu appears, listing the categories that you can
set preferences for.

2. Choose the desired category and release the
mouse button.
A specific dialog appears, allowing you to set preferences for
this category.

3. When you are done setting these preferences,
click OK.
Clicking OK saves the preferences. The next time you open
Amapi, the preferences will be set to your specifications.

Mac Preferences
Choose Preferences from the Edit Menu and release mouse

button on «Mac settings» item.

• Iconize when background : If you activate this preference,
when you quit AMAPI temporarily to use another application (or
the Finder), only the AMAPI logo is displayed, on the top left-
hand side of the screen. You go back into AMAPI by clicking on
this icon. Otherwise, the AMAPI window continues to be dis-
played in the background.

• Quickdraw drawing (Slower) : In order accelerate the display
of lines as they are drawn, we have substituted our own line
display method for the standard Macintosh QUICKDRAW. If your
system is equipped with a graphic accelerator, you may
improve display speed by activating this option.

• Fast allocator : This option improves the speed of AMAPI,
but uses quite a lot of extra memory. Adjust the value of the
standard Macintosh memory allocator. If the "Not enough MAC
memory" message is displayed, increase this value slightly.

• Stack size : In the case of operations requiring a special sys-
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tem process (in particular, using Cut or Punch on objects with
over 10 000 facets), it may be necessary to increase stack
size so that the system can process the operation.

• Print : You may choose the font, size, and style of characters
used for printing. This option is available for Clipboard, Printer,
PICT, and Illustrator output formats.

Units

This dialog allows you to choose between : millimeters (mm),
centimeters (cm), meters (m), inches (fractional), decimal inches,
pixels (screen units) and none (virtual units).

You may also define the number of decimal digits displayed.
Finally, you have the opportunity to choose the unit in which

angles are displayed (degrees or radians).

Amapi preferences

• Backup : This option saves all the shapes, including masked
shapes, automatically, every "n" minutes in a backup file.

• Undo frames : This option is used to choose the number of
previous modifications you wish to be able to cancel. Undo
management is dynamic (uses very little memory space) in
most cases. However, it is not advisable to use to high a value
if you are short of available memory space.

• Crash file : By clicking on the «crash file» you can change the
name of the file in which the current scene is to be saved in
case of systems anomaly.

• Bounding box display : This option is used to display only the
boxes surrounding the shapes in a series of movements. This
makes it possible to move around or through the scene more
quickly.
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IO settings

• For each input / output driver available, you can define the
way Amapi handles the communication with the source or des-
tination application.

• Switch axes : Use this part of the dialog to modify the orien-
tation in space of the imported or exported model, as not all
software uses the same system (X,Y,Z). If you notice that the
model is the wrong way round, use these parameters (which
will be kept as preferences) to define a proper correlation bet-
ween the position of the model in Amapi and in the other soft-
ware.

• Coordinates transformation : This value represents the redu-
cing or enlarging ratios applied in reading and writing files in
choosen format. This ensures a perfect coherence in measure-
ments between Amapi and other softwares.

• Extension: It allows you to define a default suffix for output
files.

• Clean : You may want to suppress coplanar face when rea-
ding huge and / or complex files. Enabling this option will
merge all coplanar faces of the input file, useful while some
formats are needing triangulated faces.

• Smooth / Smooth angle: You can define if you want exported
models to be automatically smoothed and for which value.
Useful to communicate easily with rendering programs.

Network preferences

• You can define how you want to handle the remote connec-
tion to an URL address, defining local network parameters (use
of proxy), as well as asking for cache files for a faster connec-
tion.
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NURBS MODE

Use the NURBS Mode command to change the design mode of
the program.

Amapi has two modes: Polyhedral modeling and NURBS mode-
ling. At a glance, know which mode you are in by checking the
indicator in the lower left corner of the screen. A “P” to the right
of the close box indicates Polyhedral mode and an “B” indicates
NURBS mode. 

Polyhedral vs. NURBS
Polyhedral modeling creates basic surfaces made up of faces

that are planar. All edges are straight. The surfaces of NURBS
models are computed from the given points The faces of a NURBS
model may be curved or planar. Edges are NURBS curves.

NURBS Benefits
NURBS models are more accurate than polyhedral models.

Using the NURBS mode allows you to output exact models The
drawback to this accuracy is slightly greater computer processing
time. Each time a NURBS model is changed, the computer must
recalculate all the equations that went into creating the model.

Amapi knows which objects on the screen are
polygonal and which are editing, the Modeling
Tools will work correctly on both polygonal and
NURBS objects, no matter which mode is cur-

rently active.

Creating a NURBS model

Most of the Construction Tools can be used in creating NURBS
models. Two of the 2D Drawing tools, the Bezier Curve and the
Polyline, cannot be created in the NURBS mode. This is because
these particular curves are not required in NURBS mode.

1. Choose NURBS Mode from the Edit menu (or hit
Command-B).

A check mark appears to the left of the menu command and
the lower left indicator shows an “B”.

3-14



2. Choose any of the Construction Tools and
create a form.
Remember that Bezier Curves and Polylines cannot be descri-

bed in NURBS mode. The NURBS form may look exactly the same
as in the polyhedral mode. You will definitely see the difference
when you try editing the NURBS model. 

NURBS construction vs. Polyhedral
construction 

The construction tools have subtle, yet important differences
in the two different design modes. 

2D Drawing Tool

The 2D Drawing Tools create forms that, for the
most part, appear to be the same in NURBS and
Polyhedral modes. A visual difference comes
when you modify them. Instead of being able to
edit individual points, you edit a bounding poly-
gon. This creates a smoother edited surface than
if created in the Polyhedral mode. 

Circle 
A NURBS circle appears to be the same as a polygonal circle.

It is actually formed of two semicircles. When you modify it, you
pull points on a bounding polygon instead of individual points on
the circle’s circumference. Modification will change all points on
one of the semicircles. 

Polylines 
Polylines are drawn ignoring NURBS mode and their description

will always be polygonal. 

Bezier 
Bezier Curves are drawn ignoring NURBS mode and their des-

cription will always be polygonal.
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Arc
A NURBS arc appears to be the same as a polygonal arc. It is

actually formed of two arcs, joined by a point in the middle. When
you modify it, you pull points on a bounding polygon instead of
individual points on the arc itself.

Rectangle 
The rectangle is one form that appears different in creation.

Instead of being formed of four points (one at each corner), a
NURBS rectangle has several points along each line. When you
modify it, the bounding polygon allows you to turn the straight
lines into curved lines. Although it appears so, the NURBS rec-
tangle is not a closed curve. Amapi does not implement Periodical
NURBS and real closed NURBS cannot be actually created. This
means that when you fillet the NURBS rectangle, only three sides
will be filleted instead of all four.

NURBS 
If you create a NURBS curve (either in NURBS mode or in

Polyhedral mode), you may modify only the points you clicked in
creating the NURBS. Pull the NURBS reference points to deform
the entire curve.

NURBS Interpolated 
NURBS Interpolated curves work the same as NURBS curves

(see above).

Mirror 2D Curve 
If you mirror a 2D NURBS curve and then modify it, you will

have the same smooth results as with the other tools. The origi-
nal curve, mirror, and connecting lines are each modified indivi-
dually.
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Sphere

The Sphere in NURBS mode has an initially smoother
appearance than Polyhedral spheres. The NURBS
sphere is formed of curved facets and is actually for-
med of two joined hemispheres. The Polyhedral

sphere is formed of flat facets. Modifying a NURBS sphere,
like other tools, results in a smoother form.

Cube
The NURBS cube has a different appearance than the
Polygonal cube. Immediately, it takes on the appea-
rance of the bounding polygon you might see surroun-
ding a 3D NURBS form during modifications. 

When you modify this cube, you have a few
extra points to work with. You could reform
a NURBS cube to become more of a sphe-
rical shape.

Rectangular Surface

The appearance of a NURBS Rectangular Surface is
different from the Polyhedral Rectangular Surface. 

Each cell of a NURBS Rectangular
Surface is divided into several
smaller cells. When you modify this
surface, the modification is smoo-
ther due to the additional facets.

Extrusion
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The Extrusion tool in NURBS mode creates quite a different
model than it does in Polyhedral mode.

Create a NURBS Extrusion

1. Choose the Extrusion tool when you have a
NURBS mode curve selected on the screen.

2. Click the curve and move the cursor. 
A bounding box appears.

3. Move the cursor to a point to end the extruded
segment and click
A smooth extrusion (with horizontal and vertical face lines)

appears inside the bounding box.

4. Click an endpoint for another extrusion seg-
ment. 
The joint between the two segments is smoothed. In the

Polyhedral mode, that joint is sharp.

5. Hit Return when you are done creating seg-
ments.

6. When notified, click one end to cap it. 
In NURBS mode, facets forming the cap are drawn.

7. Put-aside the Extrusion tool.

If you try to validate the extrusion after crea-
ting only one segment, you are not able to do

so. A NURBS curve cannot be created with
only two points, so Amapi insists that you pick

at least three points in the creation of a
NURBS extrusion.
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Sweep   
The Sweep tool does not have any special NURBS abilities.

This tool works the same way in NURBS and Polyhedral modes.

Ruled Surface

If you use the Ruled Surface tool on NURBS curves, it creates
vertical face lines in addition to the horizontal face lines created
between points you click.

Hull Surface   
If you create a Hull Surface from three NURBS mode curves,

the surface it creates behaves like other NURBS surfaces when it
comes time to modify it. If you choose a modifying tool, the sur-
face is surrounded by a bounding polygon. As with other NURBS
forms, you may relocate points on the bounding polygon to create
a smooth reformation of the surface.

Curve Extract   
The Curve Extraction tool will extract a curve from a NURBS

form just as it does from a Polyhedral form. It does not, however,
create 3D Lines. You may toggle between the Lasso and Bull’s-eye
cursor, but the Bull’s-eye selects boundary points on the selected
object only. It extracts the curves between those boundary points,
instead of drawing 3D lines between them, as in the Polyhedral
mode.
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Surface Extract   
The Surface Extract tool, even if used with NURBS forms, in

NURBS mode, will create only Polyhedral facets.

Thickness    
Do not use the Thickness tool on NURBS forms. This will

cause the NURBS forms to become Polyhedral.

Modifying a NURBS model 

The Modeling Tools work differently on NURBS models. Instead
of altering single points and faces, like in Polyhedral modeling, the
entire NURBS surface is recalculated. This allows you to perform
a smooth edit on the model. 

Tools to avoid 
Some of the Modeling tools do not work with the NURBS

mode. You can choose and use these tools on a NURBS model,
but this will cause the NURBS model to become Polyhedral. A
Polyhedral model cannot be transformed into a NURBS model. If
you want your NURBS model to remain that way, do not use these
tools:

Delete Facet Punch Cut

Fillet        Thickness

Remember that some of these tools will
cause the NURBS model to become polygonal.
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Control Polygon 
A white bounding box surrounds the current NURBS object

when you select one of the Modeling Tools. This is called the
control polygon. The points that you alter are actually the control
points on the control polygon, not the object’s points. 

1. Choose a NURBS object as the current object. 

2. Choose a tool from the Modeling Toolbox. 
The control polygon appears.

3. Use the tool to edit a point on the control poly-
gon. 
If you try to grab a point directly on the object, Amapi grabs

the nearest point on the control polygon.

NURBS modeling vs. Polyhedral
modeling

Stretch

The Stretch tool works differently on NURBS mode objects.
Instead of changing the location of one point on the object, you
change the point on a bounding polygon. Modifying the bounding
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polygon point actually reforms the surface by changing the loca-
tion of several surrounding surface points and lines.

Mold
The Mold tool works very much like the Stretch tool. The

precision of the Mold tool, by hitting the + and - Keys, can be alte-
red. This allows somewhat more variation in your edit than does
the Stretch tool.

Bend
The Bend tool does not have any special NURBS abili-

ties. This tool works predictably the same on NURBS and
Polyhedral models.

Delete Facet
Do not use the Delete Facet tool on a NURBS model. This
will cause the model to become Polyhedral.

Cut
Do not use the Cut tool on a NURBS model. This will
cause the model to become Polyhedral.

Punch
Do not use the Punch tool on a NURBS model. This will
cause the model to become Polyhedral.

Proportional Scale
The Proportional Scale tool does not have any special
NURBS abilities. This tool works the same way in NURBS

and Polyhedral modes.

Single Axis Scale
The Single Axis Scale tool does not have any special
NURBS abilities. This tool works the same way in NURBS

and Polyhedral modes.
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Smooth
When you choose the Smooth tool with a NURBS mode
form as the current object, immediately you notice a dif-

ference between NURBS and Polyhedral smoothing. 

1. Choose the Smooth tool when you have a
NURBS mode surface as the current object. 
A data box appears. In the data box, U Raw describes the spa-

cing for smoothing in the direction of object creation (mostly hori-
zontal spacing); V Raw describes the spacing for smoothing in a
direction perpendicular to the direction of object creation (mostly
vertical spacing). The larger the number, the greater is the smoo-
thing.

2. Specify the amount of smoothing.
• You may change the amount of smoothing by using the +

and - Keys (here you see immediate updates on the surface with
each key press). By default, the + and - Keys will change the No.
of U value in increments of 1. Hit the space bar and hit + or - to
change the No. of V value in increments of 1. Here U and V have
the same meaning as described in Step 1. 

OR
• To change the amount of smoothing by typing values, hit the

Tab Key and type in the data box. Hit Return to see the change on
the surface.

Fillet
Do not use the Fillet tool on a NURBS model. This will
cause the model to become Polyhedral.
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The Construction Tools
When you open Amapi, the Toolbox that is visible on the

screen contains the Construction Tools. The Construction Tools
are used to create all of the basic shapes and geometry that form
the basis of your model. This Toolbox supplies tools for creating
both 2-dimensional shapes, like rectangles and arcs and 3-dimen-
sional forms like spheres, cubes, and profiled surfaces. Use the
other Toolboxes to modify, join, and otherwise edit the forms.
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2D Drawing Tool

The 2D Drawing Tool allows you to draw 2-dimensional
shapes. When the 2D Drawing tool is selected, its icon

appears in the upper right corner of the screen. This tool has a
sub-palette of drawing tools for drawing Lines, Arcs, Circles,
Rectangles, Polylines, Bezier curves, NURBS, and Mirrored 2D
Curves. 

Using the 2D Drawing tool 

1. Pick the 2D Drawing Tool.
Amapi may display a Bull’s-eye cursor and
two axes, waiting for you to click on a point
to act as the beginning reference point for
the 2D construction. 

If you click an empty area of the screen,
Amapi will automatically snap the axes to

the closest object point it can find.

2. If necessary, click a beginning reference point.
• If there is nothing drawn on the screen, the cursor will auto-
matically snap to the center of the work bench and a click is
not necessary. That point automatically becomes your begin-
ning reference point.
• If there are objects drawn on the screen, then you must click
on a vertex of an existing object. That point becomes your
beginning reference point. This beginning reference point acts
both as a temporary origin for the 2D construction and posi-
tions the current work plane in space.

3. Pick one of the 2D tools from the upper right
corner palette. 
Once you have established the beginning reference point, then you
can pick one of the eight 2D tools that appear in the upper right
corner of the screen. The 2D shape you are about to draw will lie
in a plane that goes through the origin you clicked in step 2.
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4. Draw the 2D object according to the steps of
that tool. 

See the next section for the uses of each 2D tool.

5. Hit the Return Key to validate the object, if
necessary.
The Wand cursor becomes visible.

6. Put-aside the Wand to end working with the 2D
Drawing Tool
OR 

Pick another 2D tool from the upper right corner of
the screen and continue creating additional 2D
geometry. 

When you use any of the “open curve” 2D tools (Polyline, Arcs,
Bezier, or NURBS tools), the last point of each curve created
becomes the reference point for the beginning of a new 2D curve.
This makes it easy to string together several 2D objects. Create a
Polyline, followed by an Arc, followed by a NURBS, and so on. The
objects are linked end-to-end as a single object. The connection
point may be desactivated or re-activated by hitting the return key. 

The “closed curve” 2D tools (the Circle and the Rectangle)
allow you to continue adding additional separate objects without
putting-aside the tool.

Circle Tool

Use the Circle tool to draw a 2-dimensional circle.

Using the Circle tool

1. Click a center point for the circle. 
If you prefer, hit the Tab Key to type a value for the location of
the circle’s center. Hit the Return Key to enter the value.

2. Click a point on the circumference of the circle. 
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If you prefer, hit the Tab Key to type a value for the radius. Hit
Return to enter the value.

3. Choose the number of points defining the curve.

When the circle is complete, the +/- slider appears.
Use the + and - Keys to change the number of points used in
forming the circle. If you prefer, hit the Tab Key and type a
value.

4. Put-aside or hit return key to validate the circle.

Polyline
Use the Polyline tool to draw a series of straight connected

lines. 

Using the Polyline tool 

1. Click the polyline’s starting point. 
If you prefer, hit the Tab Key and type a value for the starting
point. Hit Return to enter the value. 

2. Click as many other points as you want to
create connected lines.
Each point you click is connected to the last point with a
straight line. If you prefer, you may hit the Tab Key to type a
value for as many other points as you want to create connec-
ted lines.

3. Hit the Return Key to validate the object.
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Locking onto the X, Y, or Z axis 

To create a perfectly horizontal or vertical line, hit the space
bar to toggle through the axes available in the current view. With
just one axis available, you are forced to keep the line on that
axis.

Using polar coordinates

At any time, you may choose between cartesian coordinates
(X,Y, Z values) and polar coordinates (distance from previous point
and angle from previous segment). To toggle between the two
coordinates modes, hold the option key and click the mouse but-
ton. Display and input of values for each point will comply with the
current coordinate mode.

Creating an irregular polygon 

When picking the last point of a connected line series, you
may click on the location of the first point again to close the form.
Once you close the form this way, it remains closed and any
points you click create additional sides on a closed irregular poly-
gon.

Creating 3D Polylines 

Between endpoint clicks, use the arrow keys and keypad to
rotate the view and working plane. You are then able to click a
point in a perpendicular plane, creating connected lines in 3D
space.

Bezier Curve

Use the Bezier Curve tool to create a curve that flows through
points you click. The Bezier curve uses a different type of formula
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than the NURBS curves. The Bezier curve is a simpler form that is
not computationally intensive, but it won’t represent aerodynamic
and other very specific curves as well as NURBS. 

Using the Bezier Curve tool 

1. Click a starting point for the curve. 
If you prefer, hit the Tab Key to type a value for the starting
point. Hit Return to enter the value. 

2. Click as many additional points as you want to
complete your Bezier Curve. 
If you prefer, hit the Tab Key to type values for as many additio-
nal points as you want. 

3. Hit the Return Key to validate the curve.

4. Choose the number of points defining the curve. 

Hit the Return Key to release the Bezier Curve tool
and display the +/- slider. Use the + and - Keys to change the
number of points used in forming the curve. If you prefer, hit
the Tab Key and type a value. Hit return key or put-aside to end
the drawing.

Creating a Closed curve 

When picking the last point of a curve, you may click on the
location of the first point again to close the form. Once you close
the form this way, it remains closed and any points you click
create additional points on a closed curve
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Arc

Use the Arc tool to draw an arc of any size. There are two
basic ways to use the Arc tool. You can choose the arc’s center
point, radius, and endpoints, or you can choose the beginning and
endpoints and a point along the arc. 

Center point-Radius-Endpoints method

1. Click a location to serve as the center point for
the arc. 

2. Click a point to indicate a point on the arc’s
radius. 
This is also the beginning point of the arc. If you prefer, you
may hit the Tab Key and type a value for the radius, hitting
Return to enter the value. 

3. Move the cursor around to define the angle of
the arc. 
Click when the arc meets your specifications (or hit the Tab
Key and type a value for the arc angle, hitting Return to enter
the value). 

If you option-click before clicking the endpoint
of the arc, the first and second points you

click become the endpoints of the arc and the
final point you click will lie somewhere on the

arc between the endpoints.
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Beginning-Middle-Endpoint method

1. After choosing the Arc tool, option-click.            
Notice that the reference lines run along the circumference of
the circle instead of through the middle. This allows you to
pick a beginning point on the circumference of the arc.

2. Click a location to serve as the beginning point
for the arc. 

3. Click a second point on the arc. 
If you prefer, hit the Tab Key and type a value for the location,
hitting Return to enter the value. 

4. Click the endpoint for the arc. 
If you prefer, hit the Tab Key and type a value for the location,
hitting Return to enter the value. 

The option-click is a toggle. Option-click a
second time and you’re back to deflnlng the

center point.

Combining the two methods 

You can combine these two methods by simply option-clicking
after any step. For example, option-click to select a point on the
arc itself. Option-click again to select the center point. Click the
endpoint. Combine methods to create arcs exactly as they are
needed in your design. 

Changing the number of points defining the curve

When the arc is completed, the +/- slider appears.
Use the + and - Keys to change the number of points used in
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forming the arc. If you prefer, hit the Tab Key and type a value.
Hit Return or put-aside to validate the arc.

Locking onto the X,Y,or Z axis 

Hit the space bar to toggle through the axes available in the
current view. Wherever the cursor is located at the time you hit
the space bar becomes a point on the axis. With one axis avai-
lable, you can only change the arc in that direction.

Rectangle

Use the Rectangle tool to create a rectangle.

Using the Rectangle tool

1. Click a point that will be one corner of the rec-
tangle. 
If you prefer, hit the Tab Key to type a value for one corner of
the rectangle. Hit Return to enter the value.

2. Click the opposite corner of the rectangle. 
If you prefer, hit the Tab Key to type a value for the opposite
corner of the rectangle. Hit Return to enter the value.

You may continue creating separate rectangles by picking the
Rectangle tool and repeating these steps until you put-aside the
2D Drawing tool.
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NURBS

Use the NURBS tool to create a curve controlled by the points
that you click. Amapi uses these vertices as a bounding polygon
for a NURBS curve. This NURBS tool will rarely create a curve that
passes through the points you click.

Using the NURBS tool

1. Click a starting point for the curve. 
If you prefer, hit the Tab Key to type a value for the starting
point. Hit Return to enter the value.

2. Click as many additional points as you want to
complete your curve. 
If you prefer, hit the Tab Key to type values for these point. Hit
Return to enter each value.

3. Hit the Return Key to validate the curve.

4. Choose the number of points defining the curve 

Hit the Return Key to accept the curve and the +/- sli-
der is displayed. Use the + and - Keys to change the number
of points used in forming the spline. If you prefer, hit the Tab
Key and type a value. The number in the data box represents
the number of points between each vertex you clicked. Hit
Return or put-aside to validate the curve.

Hold the Shift Key to snap the cursor to exis-
ting vertices in the drawing. 

4-12



Creating NURBS in 3 dimensions

After you have clicked at least one point on the curve, you can
use the Arrow Keys or number pad numbers to rotate to another
view. The drawing plane becomes the plane most parallel to the
screen. Click points on the NURBS in all three planes by using the
arrows to rotate the view and the plane.

NURBS Interpolated

Use the NURBS Interpolated tool to create a curve controlled
by the points that you click. The curve passes through these
points, which serve as vectors.

Hold the Shift Key to snap the cursor to exis-
ting vertices in the drawing. 

If you click the starting point again, you close
the curve and automatically release the tool.

Using the NURBS Interpolated tool 

1. Click a starting point for the curve. 
If you prefer, hit the Tab Key to type a value for the starting
point. Hit Return to enter the value. 

2. Click as many additional points as you want to
complete your curve.
If you prefer, hit the Tab Key to type values for these point. Hit
Return to enter each value.

3. Hit the Return Key to validate the curve. 

4. Choose the number of points defining the curve

Hit the Return Key to accept the curve and the +/- sli-
der is displayed. Use the + and - Keys to change the number
of points used in forming the spline. If you prefer, hit the Tab
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Key and type a value. The number in the data box represents
the number of points between each vertex you clicked. Hit
Return or put-aside to validate the curve.

Creating NURBS in 3 dimensions

After you have clicked at least one point on the curve, you can
use the Arrow Keys or number pad numbers to rotate to another
view. The drawing plane becomes the plane most parallel to the
screen. Click points on the curve in all three planes by using the
arrows to rotate the view and the plane. 

Important:

NURBS curves are always drawn in NURBS mode (even if
POLYHEDRAL MODE was selected from EDIT menu). Bezier curves
and polylines are always drawn in POLYHEDRAL mode (even if
NURBS MODE was selected from EDIT menu). 

Mirror 2D Curve

To create a mirror of a 2D curve, use the Mirror 2D Curve tool.

Using the Mirror 2D Curve tool

1. Create an open 2D curve.
Use the Arc, Bezier curve, Polyline, or NURBS tools. Make sure
that the connection point is displayed (do not deactivate it).

2. Click the Mirror 2D Curve tool.
As you move the cursor, a straight line appears through it. This
is the axis of symmetry.

4-14



Do not exit the 2D Drawing mode before crea-
ting the mirror.

3. Hit the space bar to change the angle (horizon-
tal or vertical) of the reflection. 
You may not use the Arrow Keys to change your view. Verify
that you are looking at the correct plane before you choose the
Mirror 2D Curve tool. 

4. Click the mouse button when the line is positio-
ned where you want the mirror located. 
A mirror image of the curve appears. It is linked to the original
curve, creating a single form.

Important:

Since Amapi does not handle periodical NURBS, in the NURBS
mode, it is technically not possible to generate a closed NURBS
curve although it may appear closed. For example, if you create a
rectangle in NURBS mode (not in polyhedral mode—see the
NURBS mode discussion in Chapter 3 for more information), you
will notice that due to the above restriction you cannot fillet the
fourth edge where the curve appears to be closed.

The 3D tools work like the 2D tools—you need to pick a refe-
rence point and then pick a starting point for the creation of the
object.

Sphere

The Sphere Tool allows you to draw 3D spheres anywhere in
the work space. With the Sphere tool selected, its icon appears in
the upper left corner of the screen.
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Using the Sphere tool

1. Pick the Sphere tool. 
Amapi may display a bull’s-eye cursor and two axes, waiting for
you to click on a point to locate the axes. If there is nothing
drawn on the screen, the axes automatically appear at the cen-
ter of the workbench.

2. Click the sphere’s beginning point. 
That point becomes the base of your sphere.

3. Complete the sphere by clicking a desired cen-
ter point with the mouse. 
OR 

Hit the Tab Key and type a value for “Radius”. Hit
the Return Key to accept the value. 

4. Choose the number of points defining the
sphere.

Once you have drawn the sphere, the “+/-” cursor
appears, allowing you to use the Plus and Minus Keys to make

4-16



the sphere more smooth or more coarse. If you prefer, you can
hit the Tab Key and type a value for “Number of Points”. Hit
the Return Key to accept the value.

5. Hit the Return Key to validate the sphere. 
The Sphere tool is released and the Wand cursor appears.
OR 

Put-aside the “+/-” cursor to validate the sphere. 

The Sphere tool is released and the Wand cursor appears. 

Cube

The Cube tool allows you to draw 3D Cubes anywhere in the
work space. With the Cube tool selected, its icon appears in the
upper left corner of the screen.

The Cube tool can creates any 3D rectangular
shape by entering X, Y and Z dimensions with

numeric input.

Using the Cube tool

1. Pick the Cube tool.
Amapi may display a Bull’s-eye cursor and two axes, waiting for
you to click on a point to locate the axes. If there is nothing
drawn on the screen, the axes automatically appear at the cen-
ter of the workbench. 

2. Click the cube’s beginning point.
That point becomes the base of your cube.
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3. Click a point on the edge of the cube’s base.
The Cube tool is released and the Wand cursor appears.

OR

Hit the Tab Key and type a value for “Dim X “,
“Dim Y” or “Dim Z” to create a rectangular 3D
shape. Hit the Return Key to accept the values.

The Cube tool is released and the Wand cursor appears.

Rectangular Surface

Use the Rectangular Surface tool if you want to create a flat
surface mesh. Shape a Rectangular Surface later with the
Modeling Tools.

Using the Rectangular Surface tool

1. Choose the Rectangular Surface tool.
Click a location to serve as the origin.

2. Click a point that will become one corner of the
Rectangular Surface.
If you prefer, hit the Tab Key and type a value for the X, Y, and
Z location, hitting Return to enter that value.

3. Click a point that defines the size of the facets,
or mesh cells, that will form the Rectangular
Surface. 
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If you prefer, hit the Tab Key and type a value for the length
and height of the cell, hitting Return to enter that value.  

4. Move the cursor to indicate the height and
length of the Rectangular Surface.
Click when you have the size you need. If you prefer, hit the
Tab Key and type values, hitting Return to enter the values for
No. of U (horizontal cells) and No. of V (vertical cells) . 

You always get complete Rectangular Surface
cells. For example, if each facet or cell is 10 X 10,

the entire Rectangular Surface can only mea-
sure a multiple of 10, such as 180 X 50,

never 182 X 47.

Extrusion

The Extrusion tool is used to take a 2D curve and build a 3D
shape based on a perpendicular projection of that 2D curve. This
is done in two different ways: 

The one-curve method

This allows you to take a single planar curve (open or closed)
and extrude it in a direction perpendicular to the plane of the
curve. You have the option of defining multiple extrusion seg-
ments and can vary the relative scale of the curve (make the
curve larger or smaller) at the end of each segment. 

3

1

2

1

2
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The two-curve method

This allows you to take a single planar curve (in this case
referred to as a “section”) and extrude it in a direction perpendi-
cular to the plane of the curve. The shape of the extrusion is crea-
ted through a second curve (referred to as a “profile”).

Using the Extrusion tool (One-Curve Method)

1. Select a 2D curve with the Wand to make it the
current object.

2. Click on the Extrusion tool. 
Using the keyboard arrows or the number pad, rotate to a view
that is approximately perpendicular to your selected object.

3. Click on the selected 2D curve to grab it.

4. Pull the curve to extrude it.

5. Click the mouse to end the first extrusion seg-
ment.
If you prefer, hit the Tab Key and type values for the radius and
height, hitting Return to enter those values.

6. Repeat steps 4 and 5 as necessary.

4-20



7. Hit the Return Key when you want to end the
extrusion. 

8. If necessary, cap each end of the shape if the
base curve is closed.
The two open ends of the extruded shape are outlined in red. 
This 2D curve must lie in one of the orthogonal planes. That
is, either the Top, Front, or Right plane.
You will get the most predictable results with the Extrude tool
by connecting one end of the profile to one vertex point of the
section. This is not required, but the results otherwise might
not be what you expected.

9. With the Wand, click on each end that you
want capped.
If you want them to remain open, just put-aside the tool.

Hit the space bar to lock onto a vertical axis,
a horizontal axis, or both axes to aid in your

extrusion.

Using the Extrusion tool (Two-Curve Method)

1. Create two curves in perpendicular planes. 
Each curve must lie in one of the orthogonal planes (Top,
Front, or Right). One curve is the “section” that will be extru-
ded over the shape of the “profile” curve.

2. Select the section with the Wand to make it
the current object.

3. Click on the Extrusion tool.

4. Click on the profile.
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An extrusion of the section that follows the shape of the profile
appears. If the section is a closed curve, the two open ends of
the extruded shape are outlined in red.

5. With the Wand, click on each end that you
want capped. 
If you want them to remain open, just put-aside the tool. 

Both of the original 2D curves become hidden
when the extruded shape is validated. This ori-

ginal curve can be brought back by using the
Show tool.

Extended Extrusion :

You can now extrude either a single curve, either a group of
curves, either a whole surface or volume, or a face of a mesh.

If the current selected object is a group composed of curves (it
must be composed only of curves), you can extrude it, both inter-
actively and by a predefined profile
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. If the current selected object is a surface (or a volume), you can
also extrude it :

. If you click into an object face, you will extrude this face,
creating this way additional geometry on your object. This may be
useful to create organic shapes from simple objects (like
spheres), by extruding some faces to construct excrescences.
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. If you click outside of the object (you dont select any face
to extrude), the whole geometry of the object will be extruded,
producing complex objects very simply.

- In the 2 curves mode, you can also snap a reference point by
pressing "alt" key + mouse click (PC = right mouse button).

This point precises where the profile curve begins, otherwise a
reference point is choosen  automatically from section points.
Useful when the curves have no common points or when the sec-
tion curve (for ex. square) have no points in the main extrusion
plane (You have to group the extrusion curves before extruding
with them). If you have 3 extrusion curves, you will obtain 3
objects.
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Sweep

The Sweep tool takes a 2D curve and builds a 3D shape
based on a projection of that 2D curve. The Sweep, however,
maintains the overall size of the “section” and can angle off in dif-
ferent directions. This is done in two different ways : 

The one-curve method

This allows you to take a single planar curve (open or closed)
and sweep it in any direction from the plane of the curve. You
have the option of defining multiple swept segments, and can vary
the angle of each segment. 

The two-curve method

This allows you to take a single planar curve (in this case
referred to as a “section”) and sweep it into a 3D shape. The
shape of the sweep is created by following a second curve (refer-
red to as a “profile”). 

Using the Sweep tool (One-Curve Method)

1. Select a 2D curve with the Wand to make it the
current object.

2. Click on the Sweep tool. 
Using the keyboard arrows or the number pad, rotate to a view
that is approximately perpendicular to your selected object.

3. Click on the selected 2D curve to grab it.

4. Pull the curve to sweep it. 

5. Click the mouse to end the first swept seg-
ment.
If you prefer, you may hit the Tab Key and type values for the
distance and angle, hitting Return to enter those values.
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6. Repeat steps 4 and 5 as necessary.

7. Hit the Return Key to end the sweep. If the sec-
tion is a closed curve, the two open ends of the
swept shape are outlined in red.

8. With the Wand, click on each end that you
want capped.
If you want them to remain open, just put-aside the tool.

This 2D curve must lie in object one of the
orthogonal planes. That is, either the Top,

Front, or Right plane.

If one vertex point of the section is connected
directly to an endpoint of the path, then that

vertex point rides directly along the path. If
the two curves are not connected, the geome-

tric center of the section follows the path.

Both of the original 2D curves become hidden
when the swept shape is validated. This origi-

nal curve can be brought back by using the
Show tool.

Using the Sweep tool (Two-Curve Method)

1. Create two curves in perpendicular planes.
Each curve must lie in one of the orthogonal planes. That is,
either the Top, Front, or Right plane. One curve is the “sec-
tion” that will be swept over the shape of the “profile” curve.

2. Select the section with the Wand to make it
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the current object.

3. Click on the Sweep tool.

4. Click on the profile. 
A sweeping of the section that follows the shape of the profile
appears. The section is oriented so that it is perpendicular to
the path at each point along the path. If the section is a close
curve the two open ends of the swept shape are outlined in
red.

5. With the Wand, click on each end that you
want capped. 
If you want them to remain open, just put-aside the tool. 

Sections scaling

Once you have created an object with the sweeping tool, while
being able to change the orientation of the sections, you are
now able to define a progressive scale on the sections. Use
"+" and "-" keys to enlarge or reduce the size of the sections
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Double sweep

This method allows you to create shapes from one section and
two profiles.
The section is repeated, oriented and adjusted according to
the two profiles, used as guides.
This allows you for example, in a single operation, to create
objects like horns, variable thickness tubes, helicoidal sur-
faces, ...

This tool works with 3D profiles (not lying in a plane), and
which can be opened or closed, which allows you an infinity of
resulting effects.
It also works in NURBS mode, and generates a NURBS surface
if the section is a NURBS curve

Using the Double-Sweep method

Create a section and 2 profiles, each sharing a common point
with the section, and preferably belonging to a perpendicular
direction of the section, select the section as the current
shape, take the Sweep tool,
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click on the double sweep mode icon (on the bot-
tom-right corner of the screen) and select the 2 pro-
files as sweeping path. Your surface is built !

Limitations :
-The 2 profiles must be either both open, either both closed.
-Each profile must share a common point with the section 
-The 2 profiles must not share the same point with the section

Orienting resulting sections

In the same time you are asked to cap ends of shape, you
may press the Space bar to toggle orientation of swept sections.
In a first time, original size of the section is unchanged but boun-
ding edges may not be parallel. By pressing a first time on the
Space bar, the size of each section if modified to keep bounding
edges parallel. By pressing a second time on the space bar, each
section will keep the original orientation of the swept curve, allo-
wing you to create a different kind of surface.

Ruled Surface

The Ruled Surface tool allows you to create a “skin” or “pat-
ched surface” between two or more 2D curves. A simple example
of this is to imagine an airplane wing. The structural ribs are the
section curves, and the “skin” of the wing results from using this
tool to connect those ribs.

The Ruled Surface tool can work with curves that are parallel
to each other, but they don’t have to be. They can move and
rotate through space.

The curves don’t need to be similar to each other or share the
same number of points. Each one can be a completely different
shape and can contain any number of points. Amapi will interpo-
late the points automatically.

The only requirement is that all the curves must be opened, or
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they all must be closed. You cannot mix opened and closed curves.

Using the Ruled Surface Tool 

1. Create some 2D curves. 

2. Pick the Ruled Surface tool. 
It does not matter what the currently selected object is. 

3. Click any point of the first curve of interest. 

4. Click an appropriate point of the second curve. 
As soon as you click, a “skin” or “patched surface” is created
between the two curves. Amapi creates a straight “ruled” line
between the two points you picked, and uses that as the basis
for creating the surface. Pick your points carefully (that is, try
to pick “related” points on each curve), because you can get
varying results depending on what you pick. 

5. Click on “related” points of additional curves, if
desired. 

6. Put-aside the cursor to validate the Ruled
Surface. 
The Ruled Surface tool is released and the Wand cursor
appears. 
OR 

Hit the Return Key to validate the Ruled Surface. 
If the original curves were closed, the two open ends of the
shape are outlined in red. 

7. With the Wand, click on each end that you
want capped. 
If you want to leave them open, put-aside the tool. 
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The orignal 2D curves become hidden when
the Ruled Surface is validated. These original

curves can be brought back by using the
Show tool.

Ruled Surface construction between surfaces

You can also create ruled surfaces patched between two sur-
faces.

Have at least two surfaces in your scene. We mean by surfaces,
polyhedral objects with open edges (e.g. not closed volumes).

Select a vertex on an open side (belonging to an edge sharing
only one face), as well as a vertex on a curve, select another
similar vertex: surface is build between the two boundaries!
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Hull Surface

Use the Hull Surface tool to create complex surfaces. This tool
allows you to create a surface that is defined by three curves
(section, profile, and contour) in three different planes or four
curves that may have any orientation in the 3D space. There are
two methods of using the Hull Surface tool: 

Three-curve method

Create three curves, one in each of the three orthogonal
planes (Top, Front, Right) that the Hull Surface tool uses to define
a surface. The section is repeated over the length of the contour
in one direction and the profile in the other. 

Four-curve method

Create four curves that may have any orientation in the space
but must share one point with another curve to form the bounda-
ries that the Hull Surface tool uses to define a surface.

Using the Hull Surface tool (Three-Curve Method)

1. Create three flat (2D) curves.
Create one in each of the three orthogonal planes (Top, Front,
Side). The contour and the section must share a common
point.

2. Choose the Hull Surface tool. 
You have to select the 3 curves in the following order: the sec-
tion, the profile, and the contour.

3. Click on each curve, in that order. 
The curves become a surface. You may hit Command-Z or
choose Undo from the Edit Menu if you make a mistake.
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4. If necessary, optimize the Surface’s Facets
Before putting-aside the tool, hit the minus (-) Key when your

hull surface is complete to optimize the facets. This matches
the number of points in each of the creation curves to the
number of facets formed. When the surface is completely opti-
mized, the minus key will no longer have any effect on its
appearance.

5. Put-aside the Hull Surface tool.

Remember when creating curves that they will
be joined as one object unless you put the

Drawing Tool aside after each use. In order for
the Hull Surface tool to work, you must have

three or four separate curves.

Using the Hull Surface tool (Four-Curve Method)

1. Create four curves. 
They may be created with any 3D orientation and dont have to
lie in a single plane (you may use 3D curves). Each curve must
share one point with another curve.

2. Choose the Hull Surface tool. 
When you enter in the tool, hit the space bar to indicate that
this will be a surface based on four curves. The 3-Curve Hull
Surface icon displayed on the upper left corner of the screen
is replaced by the 4-Curve Hull Surface icon.

The space bar command is a toggle. Before
selecting any curve, hitting on the space bar

allows you to switch between the two
construction methods. Watch the upper left

corner icon to control the method you are
going to use.
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3. Click on each curve, in any order. 
The curves become a surface. You may hit Command-Z or
choose Undo from the Edit Menu if you make a mistake.

4. Put-aside the Hull Surface tool. 

Use the + Key to flip through the selection of
each curve. The center point sphere shows for
each separate curve to verify that you have 4

separate curves.

Using the Hull Surface tool (N-Curves Method)

This tool is an extension of the 4-Curve method. It allows you
to create surfaces patched between a net of connected
curves. The generated surface will be patched between the
curves of longitude in one direction, and between the curves
of latitude in the other.

1. Create a net of connected curves, representing
the external and internal boundaries of the surface
you want to create.

2. Take the Hull Surface tool

3. Toggle with the Space Bar to see the 4-Curve
Hull Surface Icon

4. Click one by one the curves in longitude. They
turn white when selected
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5. When you have designated all the curves in lon-
gitude, Validate by pressing the Enter key. The
wand cursor becomes the designation white hand.

6. Then click one by one on the curves in latitude.
They turn white when selected

7. When you have designated all the curves in lati-
tude, Validate by pressing the Enter key.

The surface is generated, or a message is displayed if
all the curves are not correctly connected
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Limitations :

. All the curves must be connected between them like a
net

. The curves in each direction (longitude or latitude)
must be either all open, either all closed

. Even if the used curves are NURBS curves, the created
surface is always polyhedral.
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Curve Extract Tool

The Curve Extract tool creates a new curve object through
points that you select on existing objects. This new curve is used
often as the basis for a new Sweep, Extrude, or other surface
creation operation. You may select these points with three diffe-
rent methods: 

The Lasso Select method

With this method, use the Lasso cursor to select a set of exis-
ting points. A new curve object is generated through these points. 

The Point-Select method

With this method, use the Bull’s-eye (point selection) cursor to
select existing points, one at a time. A new curve object is crea-
ted through these points. You will be creating a 3D polyline
through existing geometry.

The Automatic boundaries extract method

With this method, hit the return key before entering any point.
This will automatically create the curves which define the free
edges of the current object (Top and bottom circles of an open
cylinder for example).

Using the Curve Extract tool (The Lasso-Select
method)

1. Have any 2D or 3D object already on the
screen. 
If there are many objects on the screen, make sure the object
of interest is selected. The Lasso only “sees” points of the
currently selected object. Any points of other objects contained
within the Lasso are ignored. 

2 Pick the Curve Extract tool. 
The Lasso selection cursor automatically appears.
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3. Draw a Lasso around the points of interest. Hit
the Return Key to accept the selection.

A new curve object is drawn through those points. Remember,
you must select a set of points through which it is possible to
draw a single curve. You may end up selecting an invalid set.
In this case, nothing will appear neither be created. For
example, you cannot select an entire sphere object with this
tool.

4. Repeat step 3 as desired to create additional
separate curves.
OR 

Put aside the tool to end the Curve Extract opera-
tion. 
The Wand cursor appears.

Using the Curve Extract tool (The Point-Select

method)

1. Have 2D or 3D objects already on the screen.
It doesn’t matter which is the currently selected object.

2. Pick the Curve Extract tool.
The Lasso selection cursor automatically appears.

3. Hold the Option Key and click the mouse button.
This switches the cursor from the lasso to the Bull’s-eye (point
selection) cursor.

4. Click individual points on the existing objects.
As you click, a new curve object appears from one point to the next.
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5. Hit the Return Key to accept the curve.
The Point-Selection cursor will stay active.

6. Repeat steps 4 and 5 as desired to create addi-
tional separate curves.
OR
Put aside the tool to end the Curve Extract opera-
tion.
The Wand cursor appears.

Using the Curve Extract tool (The automatic bounda-
ries extraction method)

1. Have any 2D or 3D object already selected on
the screen. 
This method extracts the boundaries of an object. So it will be
efficient only if the selected object is open (this method will
give nothing if applied to a sphere or a cube).

2 Pick the Curve Extract tool. 
The Lasso selection cursor automatically appears.

3. Hit the Return key.
One or several new curve objects are created and drawn, defi-
ning all the boundaries of the selected object. The Lasso
selection cursor is still active.

4. Lasso-extract new curves from selected object
if desired.
OR 
Put aside the tool to end the Curve Extract opera-
tion. 
The Wand cursor appears.
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Surface Extract Tool

Use the Surface Extract tool to create facets either manually,
by lasso, or automatically caping open shapes. You may need to
create facets in order to mesh a special surface or create missing
meshes on an object. The facets can then be welded together to
form a uniform entity. You can create facets of any shape, with
any number of edges. 

You may use the Surface Extract tool with three different
methods :

The Point-Select method

With this method, use the Bull’s-eye (point selection) cursor to
select existing points, one at a time. A new face object is created
through these points.

The Lasso Select method

With this method, use the Lasso cursor to select a set of exis-
ting points. A new face object is generated through these points. 

The Automatic boundaries extract method

With this method, hit the return key before entering any point.
This will automatically create the faces which cap an open object
(creating top and bottom disks on an open cylinder for example).

Using the Surface Extract tool (The Manual Select
method)

When you choose the Surface Extract tool, the Bull’s-eye cur-
sor appears.

1. Click points on the objects to identify the
points of the facet. 
If you make a mistake, hit Command-Z or choose Undo from
the Edit Menu. 
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2. When one facet is finished, hit Return.

The facet is its own object. If you create additional facets
without putting the tool away first, they will be grouped toge-
ther as one object. To create facets that are all separate enti-
ties, put-aside the tool after each facet is created. Re-choose
the Surface Extract tool to create the next facet. 

3. Click points to form additional facets or put-
aside the Surface Extraction tool.
If the surface is not correct, you may erase it using Command-
Z or Undo from the Edit Menu. Put-aside the tool to end the
Surface Extract operation.

Using the Curve Extract tool (The Lasso-Select
method)

1. Have any 2D or 3D object already selected on
the screen. 
If there are many objects on the screen, make sure the object
of interest is selected. The Lasso only “sees” points of the
currently selected object. Any points of other objects contained
within the Lasso are ignored. 

2. Pick the Surface Extract tool. 
The Bull’s-eye cursor appears.

3. Hold the Option Key and click the mouse but-
ton.
This switches the cursor from the Bull’s-eye to the lasso cur-
sor.

4. Draw a Lasso around the points of interest. Hit
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the Return Key to accept the selection.
A new face object is drawn through those points. Remember,
you must select a set of points through which it is possible to
draw a single face. You may end up selecting an invalid set. In
this case, nothing will appear neither be created. For example,
you cannot select an entire sphere object with this method.

5. Repeat step 4 as desired to create additional
separate faces.
OR 

Put aside the tool to end the Surface Extract ope-
ration. 
The Wand cursor appears.

Using the Surface Extract tool (The automatic boun-
daries extraction method)

1. Have any 2D or 3D object already selected on
the screen. 
This method extracts the boundaries of an object. So it will be
efficient only if the selected object is open (this method will
give nothing if applied to a sphere or a cube).

2 Pick the Surface Extract tool. 
The Bull’s-eye cursor appears.

3. Hit the return key.
One or several new face objects are created and drawn, caping
all the boundaries of the selected object. The point selection
cursor is still active.

4. Manualy extract new faces from any object if
desired.
OR 
Put aside the tool to end the Surface Extract ope-
ration. 

The Wand cursor appears.
4-42



You must have something drawn in the scene
to use the Surface Extract tool.

Thickness

When created, objects have infinitely thin walls. Use the thick-
ness tool to add uniform, parallel thickness to the outline of any
object. Depending on the type of object you thicken, one of two
things will happen.

1. If you are adding thickness to a surface (defined by facets)
or volume (closed surface), such as a Rectangular Surface or
sphere, you will get a wall parallel to each facet.
2. If you are adding thickness to a curve (defined by points),
such as a circle, arc, or rectangle, you will get a tube or pic-
ture-frame effect.

Amapi automatically displays the sample thick-
ness on a facet that is most perpendicular to

the screen.

Giving Thickness to a surface or a volume

1. Click the surface or the volume you want to
thicken with the Wand. 

2. Click the Thickness tool. 
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The depth is automatically shown in red on one facet of the
current object.

3. Increase or decrease the thickness. 
Use the + and - Keys on your keyboard to increment the thick-
ness. Hit the space bar to toggle thickness direction, inside or
outside the surface. If you prefer, hit the Tab Key and type a
value for the thickness, hitting Return to enter the value.

4. Click on the object with the Wand cursor. 
The thickness appears. Hit Command-Z to cancel the operation
or / and to give another thickness value.

5. Put-aside the Thickness tool.
The thickness is applied to the object and the Wand cursor appears.

Giving Thickness to a curve

1. Click the curve you want to thicken with the
Wand. 

2. Click the Thickness tool. 
The depth is automatically shown in red between two points of
the current object.

3. Increase or decrease the thickness and number
of points
Use the + and - Keys on your keyboard to increment the thick-
ness. Hit the space bar and use the + and - Keys to increment
the number of points defining the thickness. If you prefer, hit
the Tab Key and type a value for the thickness and number of
points defining the thickness, hitting Return to enter the values.

4. Click on the object with the Wand cursor. 
The thickness appears.

5. Put-aside the Thickness tool. 
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Creating an offset surface

While you are tuning the thickness value, or once you have clic-
ked to visualize the thickness result, you may click on the
"Create Offset surface" icon to obtain a separate shape. It
means that the result will be 2 separate objects, the initial one
and the object generated by the offseted surface.The create
Offset surface icon is a toggle. It means that you can switch
between the offset surface creation mode and the closed
volume creation mode.

It allows you, for example, to build complex objects with
variable thickness, since you can afterwards select the outside
(or inside) offseted surface and edit one of its sections ...
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Creating an offset curve

By default, thickness on a polyline produces a tube as
result.
While you are tuning the thickness value, or once you
have clicked to visualize the thickness result, you can,
as well as for surface thickness, toggle between the
tube creation mode and the offseted polyline creation
mode. This mode will produce an offseted polyline (you
can choose the direction of the offset by using the
Space Bar), instead of a tube surface.
To toggle mode, click on the "Create Offset curve" icon.
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The Modeling Tools
Use the Modeling Tools to modify forms you have created with

the Construction Tools.
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Stretch

The Stretch tool allows you to pick a single point of an object,
or a group of points and pull it/them into a different position. The
surface of the object stretches along with the point(s). 

This tool works two ways: 

Single Point method

This is the default condition of the tool. It allows you to grab
one point at a time and stretch them individually. 

Multiple Point method

By using both the Lasso cursor and the Bull’s-eye cursor (Point-
Selection), you can select any set of points you want and then
stretch them as a group. 

Using the Stretch tool (Single point method)

1. Click the object whose points you want to
stretch with the Wand. 
The object you want to modify must be the currently selected
object.

2. Pick the Stretch tool. 
The cursor changes to the Stretch tool icon.

3. Click a point with the Stretch tool and move it
to a different location.

As soon as you grab the point, the two axes of the work plane
appear through the point. As you stretch the point, its move-
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ment is constrained to the current work plane. You can hit the
+ and - Keys to change the increment of the axes, which
affects the snapping of the cursor on the work plane. You may
hit the space bar to constraint the cursor displacement to a
single axis (Toggle between Horizontal axis, Vertical axis and
plane). 
OR 
Hit the Tab Key and type in values for “Loc X, Y,
and Z”. 
Press Return to validate. This displaces the point in 3D space.

When you click on a point, there are likely to
be other points nearby. Amapi will always pick

the “front-most” point closest to your cursor
of the currently selected object. If you click a
point in an empty area of the drawing, Amapi

will still jump to the closest point of the
currently selected object.

Undo a stretch by hitting Command-Z before
you put the Stretch tool away.

Holding the shift key while moving the cursor,
the moved point(s) are attracted by the points of

existing shapes, allowing to snap any point of
edited shape to another point of another shape.

Multiple-point method using the Lasso cursor

1. Click the object whose points you want to
stretch with the Wand. 
The object you want to modify must be the currently selected
object.

2. Pick the Stretch tool. 
The cursor changes to the Stretch tool icon.

3. Hold the Option key and click the mouse.
The cursor changes to the Lasso cursor. 
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4. Draw a selection lasso around a group of points
that you want to stretch. Hit the Return Key to
validate selection.

The cursor changes back to the Stretch tool icon.
Option-click again and draw additional selec-

tion lassos if you want to select an additional
set of points. Remember that the lasso will

select all points of the current object that are
inside the lasso, regardless of whether they
are on the near side of the object or the far

side. Points of noncurrent objects that lie
within the lasso are ignored.

After you grab a point of the object, the move-
ment of the cursor is constrained to the

current work plane.

5. Click any one of the points with the Stretch
tool and move them all as a group to a different
location. 
As soon as you grab the point, the two axes of the work plane
appear through the point. You can hit the + and - Keys to
change the increment of the axes, which affects the snapping
of the cursor on the work plane. You may hit the space bar to
constraint the cursor displacement to a single axis (Toggle bet-
ween Horizontal axis, Vertical axis and plane). 
OR 

Hit the Tab Key and type in values for “Loc X Y,
and Z“
Press Return to validate. This displaces the points in 3D
space.
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Multiple-point method with Bull’s-eye (Point
Selection)

1. With the Wand, click the object whose points
you want to stretch. 
The object you want to modify must be the currently selected
object.

2. Pick the Stretch tool. 
The cursor changes to the Stretch tool icon.

3. Hold the Option key and click the mouse button
twice.

The cursor changes to the Lasso, and then to the Bull’s-eye
(Point Selection) cursor. 

4. Click individually on a series of points that you
want to stretch. 
As you click on each point, that point will turn red and all sur-
face edges connected to it will highlight red.

5. Hit the Return Key to validate the selection. 
The cursor changes back to the Stretch tool icon.

6. Grab any one of the points with the Stretch tool
and move them as a group to a different location. 
As soon as you grab the point, the two axes of the work plane

1

2
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appear through the point. As you stretch the point, its move-
ment is constrained to the current work plane. You can hit the +
and - Keys to change the increment of the axes, which affects
the snapping of the cursor on the work plane .You may hit the
space bar to constraint the cursor displacement to a single axis
(Toggle between Horizontal axis, Vertical axis and plane).
OR
Hit the Tab Key and type in values for “Loc X, Y,
and Z”.
Press Return to validate. This displaces the points in 3D.

If you want to deselect a point that is currently
selected, click on it with the Bull’seye cursor.

Option-click twice again and select additional
points. Points of noncurrent objects that you

click on are ignored.

NURBS curves Tangent Edition

With the stretch tool, you can now edit the tangents of the
NURBS curves, instead of editing their control polygon:

1. Have a NURBS curve as the current selected
object. 

2. Take the Stretch tool.
The control polygon appears. You may edit the points of the
control polygon by clicking on them and moving them onto the
current plane.

3. Click on the tangent edition icon

The control polygon disappears.
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4. Click directly on a point of the curve and move
the cursor
You are now manipulating the tangent at this point, allowing
you to modify the shape of the curve by controling the tan-
gency on each point.

Be careful that this method don't hold the
topology (one circle could be open) and

doesn't work on groups.

Mold

The Mold tool allows you to grab a point on an object and pull
it into a different position. As the location of this point is chan-
ged, a number of points surrounding that point move with it, crea-
ting a smooth deformation of the object. This is a totally free-form
tool. No data box is available, so modifications can only be
accomplished visually. 

Using the Mold tool 

This tool will only edit surfaces on the currently selected
object, so before you choose the tool, verify that the correct
object is selected. 

1. When you choose this tool, a hand cursor
appears.

2. Click on a point of the surface you want to
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edit.
The cursor grabs onto that point and you can see the influence
area which is red highlighted on the edited surface. Only
points that belong to this influence area will be affected by the
deformation. You can hit the + and - Keys to increase or
decrease the size of the area. The minimal size for the area
means restricting the deformation to the single point you have
choosen.

3. Move the cursor to deform the surface.
While you are editing a surface (that is, before you click the
mouse a second time to finish the molding operation), you may
hold the Control key on the keyboard and use the + and - Keys
to increase or decrease the smoothness of the edit. The less
smooth, the fewer points are affected by the move, and the
tool acts more like the Stretch tool.

4. Click the mouse button when you have edited
the surface to your liking.
To edit from another point, repeat steps 2 and 3. 

While you are deforming the surface, hit the +
or - Key to dynamically change the area being

affected by the mold.

NURBS Free Form Deformation 

NURBS technology based, to manipulate polygonal models.

1. Have a polyhedral object as the current selec-
ted object.

2. Take the Mold tool

3. Click on the Free Form Deformation
icon

A control box appears around the object.
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4. You may increase the number of control lines by
pressing the "+" key (as well as you can decrease
it by pressing the "-" key).

The Free Form Deformation box becomes now the current edi-
ted object and some manipulation tools appear on the bottom
of the screen.

5. Use the mold tool cursor to modify directly the
shape of the Deformation Box, 

OR

Pick one of the manipulation tools and apply diffe-
rent transformations on the Deformation Box (rota-
tion, scaling, ...).

You can obviously, either before taking one of the manipulation
tools, or inside of each of these tools, select a part of the
deformation box, using Option-Click (Right mouse button on
PC), and surrounding the part of the box you want to edit with
the lasso. This will allow you to make local smooth deforma-
tions, manipulating any polyhedral object as if it was a NURBS
surface.
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Bend
The Bend tool will deform the currently selected object to fol-

low a curve you provide. There are two ways to use the Bend tool.
Either draw a curve with one of the drawing tools or draw a curve
with the Bend tool itself.

Bending to a Curve Drawn with the 2D Drawing Tools 

1. Create a curve that you want the object of
interest to follow.
Use the Bezier Curve or an arc, or any composite curve.

The size of the curve you provide doesn’t mat-
ter. It is the shape that is important. The

object you are bending will keep its original
cell size, regardless of the size of the curve.

2. With the Wand cursor, click the object you want
to bend. 
The curve does not need to share a point with the object. It is
now the currently selected object.

3. Choose the Bend tool.

4. Click on the curve you want the bend to follow.

5. Put-aside the Bend tool to end the operation.
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Bending to a Curve Drawn with the Bend Tool

1. With the Wand cursor, click the object you want
to bend. 
It is now the current object.

2. Choose the Bend tool.
You see the Wand cursor

3. Click to locate the first point in a Bezier Curve
for the bend to follow.

4. Click as many points for the curve as you want. 
When the curve is done, hit the Return Key. The object bends
to take the curve’s shape, and the curve that was created is
hidden.

5. Put-aside to release the Bend tool.

Create complex surfaces

Use the Bend tool in one plane to create a bent object.
Release the tool and move to another plane. Bend the object
again to create a complex surface.

Delete Facet

Use the Delete Facet tool to remove a facet, point, or group of
facets or points from a form. The only form the Delete Facet tool
affects is the currently selected object. Use this tool to delete two
types of objects: 

Delete Faces

Use the lightning icon to delete a face off of a surface. 

Delete Points

Use the lightning icon to delete points off of a curve. In either
case, if you option-click, you toggle between the Lasso and the
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Delete Facet lightning icon. 

Deleting faces on a surface 

1. Select the surface you want to work with by
clicking it with the Wand cursor.

2. Choose the Delete Facet tool. 

3. Click a facet with the lightning cursor. 
The facet is highlighted red. 

4. Click any additional facets you want to remove. 
If you click through a deleted facet, the Delete Facet tool
removes the facet on the back of the model. 

5. Use the Arrow Keys to rotate the view. 
Everything you clicked disappears as the screen is redrawn. 

Deleted facets appear red, and since they are
surrounded by other facets, you cannot neces-

sarily tell that they have been deleted. Use
the Control Panel’s Fast Shade tool to render
the surface quickly to see that the facets are

gone.
Hold the Option Key and click to get the lasso

tool. Use the Lasso to surround a group of
facets or of points. Hit Return and the facets

are deleted.

If you make a mistake, hit Command-Z or
choose Undo from the Edit Menu.
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Deleting points on a curve 

1. Select the curve you want to work with by clic-
king it with the Wand cursor. 

2. Choose the Delete Facet tool. 

3. Click a point with the lightning cursor. 
The point disappears. If you click an endpoint of a curve, the
end line segment disappears.

Cut

Use the Cut tool to divide an object into two separate entities.
The Cut command produces a 3D cutting plane which appears
horizontal to the current view. 

Using the Cut tool 

The Cut tool will cut only the currently selected object, so verify
that the current object is the one you want to cut. When you
choose the Cut tool, the current object is bounded with a white
cube, inside of which is the cutting plane.

1. Click a location for the origin.

2. Click a location for the pivot point for the cut
angle. 

5-15



If you prefer, hit Tab and type values for this location, hitting
Return to enter the values. 

3. Move the cursor around the pivot point to
change the angle of the plane. 
Click again when the angle is correct (or hit Tab and type an
angle, hitting Return to enter the value). 

Cutting Part of a Model 

If you want to affect only part of the object, option-click to
reveal the Lasso tool before choosing the Cut tool. Surround the
part of the object you want to cut, hit Return, and choose the Cut
tool. 

Changing the cutting plane 

If the cutting plane appears in the wrong plane, hit Command-Z
or choose Undo from the Edit Menu, put-aside the Cut tool and
rotate your view.

Punch and boolean

Use the Punch tool to punch holes and create irregularly sha-
ped cuts in 3D forms or to construct an object from intersection
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of two surfaces (Boolean Operation).
This tool works to ways :

Punch a surface by a curve

By selecting an open or closed curve projected on and cutting
the surface which is the currently selected object.

Create an surface or volume from intersection of two
surfaces or volumes

By selecting a surface or volume which intersect the currently
selected surface or volume, and then choosing parts of intersec-
tions which will form the resulting shape.

Punch a surface or a volume by an open or a closed
curve

1. Create an open or closed 2D curve or line to
serve as the cutting curve.
This shape will be projected onto the model you want punched.

2. If necessary, use the Move tool (Assembly
Toolbox) to move the cutting curve. 
Move it to the location on the 3D object where you want the
cut. It doesn’t matter where in space the cutting curve is, as
long as it will intersect the model you want to cut in the cur-
rent view. The Punch tool will cut the hole perpendicular to the
plane where the cutting curve lies.

3. With the Wand, click the model that you want
to have punched. 
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4. Choose the Punch tool.

A closed curve will create a hole filled with a
plug in the curve’s shape An open curve will

create a cut in the object of interest. 
The 2d parts may then be moved as separate

objects.

5. Click the cutting curve.
Depending on how complicated your models are, you may see
some dialog boxes indicating that Amapi is calculating the cut.

If you punch a hole in a faceted object, addi-
tional lines are added after the punch to

create facets around the hole.

6. The pattern is cut into the model and internal
facets are generated.

Punching Holes in part of an object

Before choosing the Punch tool, use the Lasso or Bull’s-eye
cursor to select points forming the surface you want punched.
When you choose the Punch tool, the cutting curve is only projec-
ted onto that one surface, instead of all the way through the
model.

If you used a closed curve to create the hole
Amapi creates the hole through the model and

creates a plug to fill the hole. The plug is a
separate entity and can be moved or deleted.
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Create an surface or volume by intersecting two sur-
faces or volumes 

1. With the Wand, click one of the two surfaces or
volume you want to intersect.
It becomes the currently selected object.

2. Choose the Punch tool.

3. With the Wand, click the second surface or
volume you want to intersect with the currently
selected model.
The intersection between the two models is computed (it may
take some time on complex models). And the first combination
of the two objects intersection is shown.

4. Use + and - keys to display successiveley the
different combinations between the two intersec-
ted objects and press return key when wanted
shape is shown.
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Proportional Scale
This tool modifies the size of the current object. It expands or

shrinks the object in all directions at once. 

Using the Proportional Scale tool 

When you choose the Proportional Scale tool, the currently
selected object is bounded with a white cube, which expands or
shrinks along with the object.

• Click to start the proportional scale. Move the cursor around
to change the size of the object and click the ending point.

OR
• Hit the Tab Key and type a value for the size that you want
the object to become. Hit Return to enter the values. 

Since this tool proportionally changes the
size, you need to type only one dimension in

the data box. To change this dimension to one
axis or the other, toggle between the axes by

hitting the space bar.

Changing the Fixed Point 

When you use the Proportional Scale tool, one point on the
model stays exactly where it was. By default, this fixed point of
the scale is the base of the model, it means the center of the bot-
tom face of the bounding cube.

1. With the Proportional Scale tool selected, hold
the Option Key and click the mouse.
You will get an X cursor.

2. Click a different location for the fixed point. 
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Scaling part of an object 

The Lasso and Bull’s-eye cursors are also available if you
option-click. Use the Lasso to surround a part of the object you
want to scale or the Bull’s-eye to choose specific points for sca-
ling.

Single Axis Scale

This tool modifies the size of the current object. It expands or
shrinks the object in only one direction, from the base of the
object (the center of the bottom face of it bounding cube).

Using the Single Axis Scale tool 

When you choose the Single Axis Scale tool, the currently
selected object is outlined with a white cube, which expands or
shrinks along with the object. 

• Click to start the expansion. Move the cursor around to
change the size of the object and click the ending point. Hit
the space bar to toggle between the two axes available in the
current view.

OR
• Hit the Tab Key and type values for the size that you want
the object to become. Hit Return to enter the values. 

Changing the Fixed Point 

When you use the Single Axis Scale tool, one point on the
model stays exactly where it was. By default, this fixed point of
the scale is the base of the model, it means the center of the bot-
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tom face of the bounding cube.

1. With the Single Axis Scale tool selected, hold
the Option Key and click the mouse.
You will get an X cursor.

2. Click a different location for the fixed point. 

Scaling part of an object 

The Lasso and Bull’s-eye cursors are also available if you
option-click. Use the Lasso cursor to surround a part of the object
you want to expand or the Bull’s-eye to choose specific points for
expanding.

Smooth

Use the Smooth tool to increase the number of facets forming
a surface, and thus creating a smoother surface. When smoo-
thed, existing facets are replaced with a finer mesh formed of
Bezier surfaces. You may also use the smooth tool to add points
to a curve. Straight lines can become curved lines using the
Smooth tool. 

Smoothing a surface or volume 

1. Click a surface you want to smooth with the
Wand cursor. 

2. Choose the Smooth tool. 
An area of tighter mesh automatically appears on the selected
object.
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3. Use the + and - Keys to increase or decrease
the number of facets replacing each unsmoothed
facet. 
If you prefer, hit the Tab Key and type a value for the number
of facets.

4. Click the object to see a preview of the smoo-
thing.

If you put the Smooth tool away now or rotate the view, the
smooth appearance will not remain on the screen. The object,
however, is tagged by Amapi as being smoothed. When you
export or paint, it will be a smoothed object. You can create
permanent on-screen smoothing, if you want.

Try a fast shading on a tagged model to see
that it is smoothed.

Permanent on-screen smoothing

If you want to keep the smooth appearance on the screen, hit
the Return Key after smoothing the model. You may need to gene-
rate the smoothing in order to do some other manipulations on
the model. Be aware that the smoother the model, the more it will
slow down screen redraws.
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Defining sharp edges

Smoothing creates curved objects from straight ones. It means
that the generated faces will define a continuous geometry bet-
ween all the original unsmoothed faces. In some case, you may
want to keep some angles sharp.

You have to ways to do that :
• Selecting sharp edges : by surrounding with the lasso or
selecting the points of the edges you want to keep sharp.

• Tuning fracture angle : by defining using + and - keys or ente-
ring a numerical value, the angle at which the continuity of the
surface will be interrupted.

Selecting sharp edges

1. After choosing the Smooth tool, option-click to
reveal the Lasso or Bull’s-eye cursor. 
Use one of these tools to surround or select point by point the
edges you want to keep sharp. 

2. Hit Return. 
The edges you have selected become white and will stay
sharp. The Wand cursor appears and you may click to see the
preview of the smoothed object or hit the Return key to keep
permanent on-screen smoothing.

Tuning fracture angle

1. After choosing the Smooth tool, option-click to
reveal the Lasso.
You can see that the lower left corner dialog box indicates now
the current fracture angle.
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2. Use + and - keys on the keyboard to increase or
decrease the fracture angle.
OR

Hit the tab key and type a value for the fracture
angle.
You see some edges displayed in white, indicating that they
become sharp, because sharing faces that form an angle smal-
ler than the fracture angle.

You may both combine selecting sharp edges
by lasso or bull’s-eye cursor and defining the

fracture angle to control which part of the
model will be curved or not.

Smoothing a curve 

1 Click a curve you want to smooth with the Wand
cursor. 

2 Choose the Smooth tool. 
The smoothness is indicated by additional points along the sur-
face of the curve.

3. Use the + and - Keys to increase or decrease
the number of points replacing each unsmoothed
point. 
If you prefer, hit the Tab Key and type a value for the number
of points.

4. Click the object to see a preview of the smoo-
thing.

Adding points to a straightline

When you select a straight line and choose the Smooth tool,

5-25



additional points are added to that line. Also, the line is smoothed
(and no longer straight) according to Amapi defaults.

1. With a straight line(s) selected, choose the
Smooth tool. 
A data box with the range appears and points are added to the
line.

2. Use the + or - Keys to change the number of
segments the smoothed line will have. 
If you prefer, hit the Tab Key and type a value for the range. Hit
Return to enter the value.

3. Option-click to reveal an angle data box. 
This angle is the largest measurement an angle between two
lines can have without Amapi trying to smooth it.

4 Use the + and - Keys to increase or decrease
the angle until the line is straight again. 
If you prefer, hit the Tab Key and type a value for the angle. Hit
Return to enter the value.        

Fillet

This tool allows you to create fillets on the edges of a surface
or volume or at the points of curves. The Fillet tool will create both
internal and external fillets, depending on the orientation of the
model’s edges. You can create fillets with variable radii. The Fillet
tool is also an easy way to create an arc tangent to two lines. 

Using the Fillet tool 

1. Use the Wand, Lasso, or Bull’s-eye cursor to
select the object or edges you want to fillet. 

2. Choose the Fillet tool. 
Fillets appear on a 2D object as points forming the fillet’s

5-26



curve. Fillets appear on a 3D object as parallel lines forming
the fillet’s edge. 

3. Use the + and - Keys on the keyboard to
increase or decrease the radius of the fillet. 
Notice the change taking place on the drawing. Hit the space
bar and use the + and - Keys to change the number of points
defining the fillet. If you prefer, hit the Tab Key and type a
value for the radius and number of points defining the fillet, hit-
ting Return to enter the values.

4. Click the drawing to see a preview of the fillets. 

5. Hit Return to validate your fillets.

Partial filleting

If you want to fillet only parts of the model, before choosing
the fillet tool, option-click to reveal the Lasso or Bull’s-eye cursor.
Select the edges you want to fillet and hit Return. Then choose
the Fillet Tool. Filletting will be applied only to selected edges.

Variable Radius Fillets

You may need a fillet that has a larger radius at one end of the
edge than at the other end.

1. Create fillets as normal.

2. When one end of your edge is filleted as you
want it, option click once to get the Lasso or
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twice to get the Bull’s-eye cursor.

3. Deselect the point whose fillet is as you want it.
Hit Return when all necessary points have been deselected.

4. Use the + and - Keys to increase or decrease
the radius of the still-selected points.
The point(s) you deselected remain the same.

5. Click the model to see a preview. Hlt Return to
keep tne filleting.

In this example, the right two points were
deselected.
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The Assembly Tools
Use the Assembly Tools when you are ready to move, dupli-

cate, combine, or separate objects on the screen.
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Move

Use the Move tool if you want to change the location of the
current obiect. 

Using the Move tool

1. Click the object you want to move with the
Wand. 

2. Click the Move tool. 

3. Click the mouse button to set an origin for the
move. 
Use the + and - Keys to increase or decrease the number of
hash marks on the axes thus increasing or decreasing the pre-
cision of the move.

4. To move in one direction only, hit the space bar
to toggle through the axes available in the current
view. 
With just one axis available, you are forced to keep the object
on that axis.

5. Move the cursor around to relocate the object.
Click at the object’s new location. 
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If you prefer, hit the Tab Key and type a value for the new loca-
tion, hitting Return to enter it.

6. Put-aside the Move tool. 

While moving the bounding box of the current
object, you may hold the Control key. The

shape itself will be redrawn, instead of the
bounding box.

Rotate

Use the Rotate tool to rotate the currently selected object. The
Rotate tool allows you to change the center of rotation and
change the rotation plane.

Using the Rotate Tool 

1. Click the object you want to rotate with the
Wand. 
If you want to rotate only part of an object, option-click to
reveal the Lasso and Bull’s-eye. Choose the points you want
rotate and hit Return. 

2. Click the Rotate tool.

A circle appears around the currently selected object. You may
change the plane, if you like. Use the Arrow Keys or the num-
ber pad to rotate to another view. When the working plane
changes, the rotation circle changes with it. The rotation plane
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is always the most perpendicular plane to the view.

3. Click a starting point for the rotation. 
If you click away from the rotation circle, the circle grows or
shrinks. This is just a visual convenience for you; it has no
effect on the tool itself. Use the + and - Keys to increase or
decrease the number of hash marks on the rotation circle.

4. Click an ending point for the rotation. 
If you prefer, hit the Tab Key and type an angle of rotation, hit-
ting Return to enter it.

5. Put-aside the Rotate tool.

Changing the Center of Rotation

By default, the rotation is centered around the object’s true
center of geometry. This rotation point remains fixed throughout
the rotation. You may change this center of rotation.

1. Choose the Rotate tool.

2. Hold the Option Key and click the mouse but-
ton.
You see an icon that looks like an X.

3. Click a different location for the center of rota-
tion. 
The rotation point will snap to the nearest point on any object
in the scene.

Snap

Use the Snap tool to snap a point on the current object onto
another point or to align an object with another, along an axis.
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Using the Snap tool

1. Click the object you want to snap with the
Wand. 
To snap part of an object, option-click to reveal the Lasso or
Bull’s-eye cursor. Select the points you want to snap.

2. Click the Snap tool.
The Bull’s-eye cursor and two axes appear.

3. If desired, hit the space bar to restrict the dis-
placement to a single-axis.
This allows you to align an object with an other. Hitting space
bar again toggles the single axis, hitting it a third time reveal
the two axes again.

4. Click one point on the current object.

5. Click the corresponding point on another
object.
The two polnts are joined. If you do not want to snap point-to-
point, click two points somewhere in space and they will serve
as a vector for the snap. 

If you select part of the object, the selected
points snap to another object and any points

that were not selected remain where they
were, deforming the original shape.
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Lay On
Use the Lay On tool if you want to place one object on another,

most likely changing the orientation of one of the objects. An
object laid on another remains a separate object. 

Using the Lay On tool

In this example, the base of the pyramid was
laid on one side of the cube.

1. Click the object you want to move with the
Wand cursor. 

2. Choose the Lay On tool. 
When you choose this tool, the base facet of the current object
becomes highlighted. You can change which facet is highligh-
ted by clicking on another facet. 

3. Click the corresponding facet on another
object. 
The first facet is laid flat on the second facet. The current
object’s orientation is rotated as necessary for the facets to
lie flat against each other. 

4. Put-aside the Lay On tool to release it. 

Weld

Use the Weld tool to fasten two or more elements or points
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together. Welding will cause the elements to become one object.
You can use the weld tool to do two things:

• Weld 2 or more objects together: Use the Weld tool to
connect two or more objects. This creates one object.
• Weld 2 or more points on one object: Use the Weld tool to
join two or more points on a single object. This causes the
object to take on a different shape.

Welding 2+ objects together

1. Choose the Weld tool. 
When you choose this tool, the Lasso cursor appears.

2. Surround the area you want to weld.

3. Hit the Return key. 
The points you surrounded are welded together. Any duplicated
points are eliminated.
If you make a mistake, hit Command-Z or choose Undo from
the Edit Menu.

Welding points on a single object

1. Choose the Weld tool. 
When you choose this tool, the Lasso cursor appears. Use the
Lasso to surround points or option-click to get the Bull’s-eye.

2. Select points that you want to weld together.
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3. Hit Return when you are done choosing points. 
Amapi merges the points according to the center of geometry
of the selection. 

In this example, the top four points of the
cube were welded to form the top point of the

pyramid.

Duplicate

Use the Duplicate tool if you want to create multiple copies of
the current object. There are several different ways to create
duplicates. You can create a single copy, multiple copies, and
duplicate objects along the points of a curve or facets of a sur-
face.

Making a single copy 

1. Have any object on the screen.
The object you want to duplicate does not have to be the cur-
rent object. To duplicate part of an object, option-click to reveal
the Lasso or Bull’s-eye cursor. Select the points you want to
duplicate and hit Return. 

2. Click the Duplicate tool. 
The cursor looks like the Move tool. 

3. Click on the object you want to copy. 
A box, with the duplicate inside, appears at the location of the
nearest point you have clicked.

Use the space bar to lock onto an axis to
move the duplicate in one direction only.

4. Click a new location for the duplicate. 
If you prefer, you can hit the Tab Key and type in an exact loca-
tion for the duplicate, hitting Return to validate.
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5. You may continue making duplicates of any
screen object. 

6. Put-aside the Duplicate tool.

Making Multiple Copies

1. Click the object you want to duplicate with the
Wand.

2. Choose the Duplicate tool.

4. Hit the Tab Key to enter in the number of copies
data box.

5. Type the desired number of copies. 
Hit Return to enter the value.

6. Type the duplicates’ displacement.
Hit the Tab and type in a value for the X, Y, Z displacement of
each duplicate from the one before it. Hit Return to enter the
value.

7. Type the rotation for each copy.
Hit the Tab Key and type a value for the rotation of each copy.
This value is the degree rotation from the previous copy. Hit
Return to enter the value.
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8. The duplicates appear. 

By default, the duplicates are grouped toge-
ther. To ungroup them, choose the Ungroup

tool from the Control Panel.

Duplicate objects along a curve

1. Create a curve that will serve as a path along
which duplicates will be made.
By default, the number of duplicates is equal to the number of
points forming this curve.

2. Create an object to duplicate along the path.

3. Make sure that the object you want duplicated
is the current object.

4. Choose the Duplicate tool.

5. Hit the space bar to indicate multiple copies. 
The duplicates have not appeared yet, but now is the time to
set the fixed duplication point. By default, the duplicates will
appear on the curve, each base point matched to a point on
the curve.

6. To change the fixed point, hold the Option Key
and click the mouse. With this X cursor, you can
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click a different location for the fixed point.

7. Click the curve.
Duplicated objects appear. By default, the duplicates are orien-
ted exactly the same as the original.

8. Hit the space bar to change the orientation of
the duplicates.
• Space bar once: duplicates rotated on the X axis.
• Space bar twice: duplicates rotated on the Y axis.
• Space bar three times: duplicates rotated on the Z axis.
• Space bar four times: facets of the duplicates lie directly
along the curve.

9. You can use the + and - keys to enlarge or
reduce the size of the last copy or use the Tab key
to define an accurate scaling ratio.
The duplicates within the first and the last copy will be scaled
proportionally.

Duplicate objects on a surface

If you want to use a faceted surface as the duplication path,
follow the same steps as for creating duplicates along a curve,
clicking the surface instead of the curve in step 7. One duplicate
will appear at the center of each facet. Hit the space bar for the
duplicates to orient themselves to each facet.
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The curve and the original duplicating object
are hidden. They can be shown using the

Show tool from the Control Panel.

Mirror 3D

Use the Mirror 3D tool if you want to create a reflection of a
3D object or a 2D object.

Mirror a 3D object

1. Click the object you want to mirror with the
Wand. 
If you want to reflect only part of an object, hold the Option
Key and click the mouse button until you get the Lasso or
Bull’s-eye cursor. Use this to choose points that you want to
reflect. Hit Return when you are finished choosing points.

2. Click the Mirror 3D tool. 
A white cube surrounds the current object.

3. Click the facet of the cube that you want to
serve as the mirror plane.
The reflection appears.

Mirror a 2D object

1. Click the object you want to mirror with the
Wand. 
If you want to reflect only part of an object, hold the Option
Key and click the mouse button until you get the Lasso or
Bull’s-eye cursor. Use this to choose points that you want to
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reflect. Hit Return when you are finished choosing points. 

2. Click the Mirror 3D tool. 
A white rectangle surrounds the current object. 

3. Hit the space bar to toggle between the two
available mirror planes (one for each available
axis). 

4. Click on the side of the object you want the
reflection to appear. Changing the Location of the
Mirror 
By default, the mirror is located on any facet of the surroun-
ding white box. If you hold the Option Key and click the mouse
with the Mirror 3D tool selected, you can click a different loca-
tion for the mirror, creating an overlapping mirror image. This
location snaps to the nearest point, however, so you may need
to create a temporary mirror location with a drawing tool.

Unfold

Use the Unfold tool to create a 2D, unfolded, planar version of
your 3D model. For instance, if you draw a 3D cardboard box, the
Unfold command will display the flat cardboard pieces needed to
construct the box. You control and manipulate the unfolding of
your model through three actions:

1. Choose the lines along which the cut will take
place.

2. Choose the facet to begin the unfold.

3. View which points and facets correspond bet-
ween the original model and the unfolded pieces. 
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Using the Unfold tool

If the current object is one that has been unfolded already and
you choose the Unfold tool, you are automatically working on the
unfolded version. See the section on viewing the correspondances
to see how you can work with an unfolded model.

Choosing the cut edges and the beginning facet

1. Select the object you want to unfold.

2. Choose the Unfold tool. 

You have the Lasso cursor and will see a palette offering the
options you have in the upper right corner of the screen :
• The bull’s-eye and the lasso icons allow you to select the
edges along which the cut will take place (by surrounding
edges with the lasso, and by selecting edges point by point
with the bull’s-eye, ending by the Return key).
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• The cut-by-section icon (like a ball in concentric vertical
circles) will be used to select cut edges automatically by sec-
tion (if the model’s topology allows it).
• The cut-by-slice icon (like a ball in horizontal circles) will be
used to select cut edges automatically by slice (if the model’s
topology allows it).
• The gray ball will be used to cancel all the cut edges.
• The white hand cursor will be used to select the face on the
model where the unfolding operation will begin.
• The Unfold icon (showing an unfolded cube) will start the
unfolding operation.

3. Option-click to toggle between the Lasso, the
Bull’s-eye cursor and the Hand cursor, if neces-
sary. 
Select the endpoints, of lines that will become the cut edges
of the unfolded object. If, when you perform the actual unfold,
you have not identified all of the necessary edges to unfold,
Amapi will add cut edges as needed.
OR
if the Hand cursor is active, click in the facet you want to
become the starting facet for the unfolding (Amapi selects a
default facet).

To activate Lasso, Bull’s-eye and Hand cur-
sors, you may either pick them directly in the

Unfold palette, or option-click to reveal each of
these three cursor, in a cyclical manner.

If you want Amapi to unfold the model based
on defaults, directly select the Unfold icon in

the Unfold palette.

Unfolding the model

When you have defined cut edges and starting facet as you
desire, 
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1. Choose the Unfolding icon in the Unfold palette
The origlnal object remains unchanged and an unfolded version
of it appears on the horizontal plane. 
The cursor becomes the Bull’s-eye and you are now able to
view the correspondances between the points and facets of
the original model and the points and facets of unfolded
pieces. 
You may cancel the Unfold by hitting Command-Z or choosing
Undo from Edit menu.

View Corresponding Points and Facets

Once you have unfolded your model, the Bull’s-eye cursor
appears and you have the opportunity to display corresponding
points and facets on the original and unfolded models. 

1. Click a point on the unfolded model. 
The corresponding point on the original model is highlighted.
Continue to click additional points, displaying their correspon-
ding locations.
OR 

Click a point on the original model. 
The corresponding point on the unfolded model is highlighted.

2. Hold the Option Key and click the mouse button
to toggle between the Bull’s-eye (point selection)
and the gray Hand (facet selection) cursors. 
This cursor allows you to click a facet on either the unfolded or
original model. The corresponding facet is highlighted on the
other model.

Selecting highlighted points or facets hide the
vizualisation of correspondance. 

Releasing the Unfold tool

Put-aside the Unfold tool when you are finished. 
The Wand cursor appears.
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The Control Panel
The Control Panel gives you the ability to choose different set-

tings and views for your drawing so that Amapi works best for you.
To gain access to the Control Panel, drag the cursor off the bot-
tom of the screen. The Control Panel tools are also available in
the Utilities Menu.
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Group

Use the Group tool if you want two or more objects to behave
as one object. This is not a physical association of the two
objects, as welding is. Grouping is easily undone with the Ungroup
tool. 

Using the Group tool 

1. Choose the Group tool. 
The Wand cursor appears. 

2. Click the objects that you want grouped. 
The outlines of selected objects will turn white. Option-click
when you have the Group tool selected to reveal the Lasso.
Surround the items you want grouped and hit Return. The
selected items are grouped.

3. If you make a mistake, hit Command-Z or
choose Undo from the Edit Menu.

4. Put-aside the Group tool.

5. Click on the grouped objects with the Wand
cursor. 
They are all selected. 

Ungroup

Use the Ungroup tool if you want to separate objects that are
grouped. 
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Using the Ungroup tool 

1. Choose the Ungroup tool.
A white cube surrounds each of the groups. 

2. Click the cube.
This causes all the items in the group to become independent. 

3. Put-aside the Ungroup tool.

Using the Go Into / Go Out of a group tool

If you whish to work on a single element of a group, but
without having to ungroup the linked objects, you may use the
Go Into / Go Out main level icons.

When the current selected object is a group, at main
level, you can click on the «Go Into the group» icon. The
remains of the scene will be temporarly hidden and the

current group will be unlinked, allowing you to work easily on a
single element. 

When you are finished, clik on the «Go Out of the group»
icon. The group will be automatically relinked and the
scene will be restored.

Show

Use the Show tool if you want to show objects hidden with the
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Hide command or objects that Amapi automatically hides. Amapi
automatically hides objects such as curves used in creating
sweeps and extrusions.

Using the Show tool

1. Choose the Show tool. 
You see a white phantom icon and the current screen vanishes
to show only the hidden objects.

2. Click objects you want to become visible. 
Selected objects are highlighted in white. Hidden objects
remain in the same position as when they were made invisible,
so when they reappear, they return to their same position.

3. Put-aside the Show tool.                                   

Hide

Use the Hide tool if you want to hide some of the objects on
the screen. This is useful if you need to remove something that is
in the way of another object. 

Using the Hide tool 

1. Choose the Hide tool.
A gray phantom icon appears. 

2. Click objects that you want to become hidden.
Each object you click turns white.

3. If you make a mistake, hit Command-Z or
choose Undo from the Edit Menu. 

4. Put-aside the tool.
The objects you clicked are hidden.
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If you want to hide or show any object on the
screen, hit the Return key. All objects present
will be hidden / shown and you will automati-

cally quit the tool.

Showing Hidden objects 

Hidden objects remain in the same position as when you hid
them, so if you bring them back, they return to their same position.
Choose the Show tool and click objects you want to be visible again. 

Hiding the workbench and background grid 

Using the Hide tool, you can hide the workbench and back-
ground grid. Simply click them with the Hide tool. As with other
screen objects, use the Show tool to bring them back.

Rear facets/hidden lines

Use the Rear facets/hidden lines tool if you want to hide rear
facets and hidden lines. You may want to do this to view your
design as you would see it manufactured.

Using the Rear facets/hidden lines tool

1. Choose the Rear facets/hidden lines tool. 
The view is immediately changed to show only the front facets
and lines.

2. Rotate the view with the Arrow Keys. 
Rear facets and hidden lines are relocated. Amapi redraws the
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current front facets and lines to achieve the same effect from
any angle.

3. Hit the space bar to toggle between wireframes
and a solid style of drawing.

4. Put-aside this tool to return to the previous
view. 

Perspective

Use this tool if you want to view your design from one orthogo-
nal plane only. 

Using the Perspective tool.

1. Choose the Perspective tool. 
The view is immediately changed to show only the two dimen-
sions forming the plane parallel to the current view.

2. Use the Arrow Keys to rotate the drawing. 
You can only view the drawing planes—top, front, right, bottom,
back, and left. The Arrows will not incrementally rotate in the
Perspective view.
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3. Choose the tool again to return to the polygonal
view. 

Working Plane

Use the Working Plane tool if you want to create a working
plane that is not one of the three orthogonal working planes.
When designing, you may create a surface on a plane other than
the three traditional planes. To create more forms using this
plane, identify it using the Working Plane tool.

Changing the Working Plane 

1. Click the Working Plane icon. 

2. Click a facet that is on the plane you want to
define. 
OR

Hold option key and click the mouse button.
The Bull’s-eye cursor appears and you have the opportunity to click 3
points anywhere on existing geometry to define the new working plane.

Amapi rotates the geometry so that this plane matches the
nearest orthogonal plane. You are free to put-aside the
Working Plane tool and use other tools to work on this plane.

3. Choose the Working Plane tool when you are
through working with your custom plane. 
The geometry rotates back to its original position. 
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Delete Entity

Use the Delete Entity command to erase an object on the
screen. 

Using the Delete Entity Tool 

1. Choose the Delete Entity tool.
You see a Disintegrator Gun icon. 

2. Click the object you want to disintegrate. 
It disappears. If you click the mouse button without the
Disintegrator Gun touching an object, it will erase the object
nearest to it, so be careful that you are erasing what you want
to erase. 

3. If you make a mistake, hit Command-Z or
choose Undo from the Edit Menu. 

4. Put-aside the tool. 

Erasing the Entire Scene 

If you want to erase everything in the scene, your best choice
is to use the Black Hole in the Catalog. If you choose the Catalog
from any Toolbox and immediately click the Black Hole, the entire
scene is erased. Note that by doing this, you are not deleting the
file itself but only its contents. You can undo this operation if you
decide you want everything back.

Fast Shade

Use this tool if you want to paint an object or change the color
of its outline. When you use the tool to create solid color on an
object, the color Amapi uses is the outline color of the object. 

Creating solid color 
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1. Choose the Fast Shade tool. 
You see a rectangle whose center is marked with an X. Use
this to outline an area you want to color.

2. Click a location for the center of the rectangle. 
Move the cursor to expand the box. 

3. Click the mouse button when the box is the
size you need. 

The area inside the box becomes shaded with solid color. If an
object was smoothed (either with permanent on-screen smoo-
thing, either only tagged), it is displayed using Gouraud or
Phong smooth shading, depending on the relevant preference
(see Amapi preferences section). Otherwise, it is displayed in
flat shading, e.g. using one color by facet.

If you want to paint the entire scene, hit the
Return key immediately after choosing the

Fast Shade tool.

Choosing an outline color

1. Choose the Fast Shade tool.

2. Hit the space bar to reveal the Wand cursor.

3. Click the object you want to have a different
color. 
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A color palette appears.

4. Choose the color you want to change it to and
click OK.
The outline changes color and if you choose to create solid
color for the object, this is the color you get.

5. To keep the original color, click Cancel in step 4.

View Point
The center of the workbench is the default

center of the screen. To return to this default
after using the View point tool, click the Zoom

Extents tool.

Use the View Point tool if you want to be able to change the
center of the screen. The View Point tool also changes the pivot
point used in rotating the drawing area with the arrow keys. This
will allow you to view your design from any angle necessary.

Uslng the Vlew Polnt tool

1. Choose the View Point tool.
You see a cursor that looks like an eye.

2. Click a location to become the center of the
screen and the view rotation pivot point. 
If you prefer, hit the Tab Key and type a location, hitting Return
to enter the value.

3. Hit the 3 Key on the number pad. 
The scene is zoomed toward the new center. Hit the Decimal
Point Key to zoom out again.

4. Try using the Arrow Keys to rotate the view. 
The point you clicked is now the pivot point for the rotation.
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5. Put-aside the View Point tool.

Zoom Window
Zoom In Shortcut: Hitting the 3 on the number

pad will zoom in on the drawing
Use the Zoom Window tool if you want to zoom in on all or part

of the drawing.

Using the Zoom Window tool

1. Choose the Zoom Window tool.
You see a rectangle with its center marked as an X.

2. Click a location to serve as the center of the
zoom.
Move the cursor to expand or shrink the zoom box.

3. Click when the zoom box encompasses the geo-
metry you want to zoom. 
The area inside the box zooms to fit the screen.

Zoom Extents

Zoom Out Shortcut: Hitting the decimal point
on the number pad will zoom out.

Use the Zoom Extents tool if you want to back off from the dra-
wing and view the whole design at once. This tool will zoom so
that the center of the screen is the center of all geometry.

Using the Zoom Extents tool

Click the Zoom Extents tool and the screen immediately
changes to show you the entire design.
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Measure

Use the Measure tool to add dimensions to your design. Amapi
allows for three types of dimensions: linear, angular, and
volume/area/circumference measurements. 

You may also reposition or delete measurements. A palette
offering these different possibilities appears in the upper right cor-
ner of the screen when you choose the Measure tool.

Linear Measurements

When you choose the Measure tool, the cursor looks like the
Bull’s-eye. With this cursor, you can dimension linear distances. If
another cursor is active, pick the bull’s-eye icon in the upper right
palette.

You must click very near the point you need,
because the Measure tool will snap to the clo-
sest point. You may not get an accurate mea-

surement if you are not careful.

1. Click two points at opposite ends of the dimen-
sion you want.
The default dimension is a single-axis measurement between
the two points. 

7-14



a. Hit the space bar once.
You get the other-axis measurement between the two points. 

b. Hit the space bar again.
You get the oblique (3D distance) measurement between the
two points.

2. Move cursor and click a third point to indicate
the location of the dimension line.

Angular Measurements

By default, the first type of measuring tool that appears is the
Linear dimension tool. If you option-click, you will see the Angular
dimension icon. You may also pick the Angular measure cursor
from the upper right palette.

1. Click the endpoint of one leg of the angle.

2. Click the vertex of the angle.

3. Click the endpoint of the other leg of the angle. 
The dimension appears near the vertex.

4. Move the cursor and click a location for the
angle measurement.

Volume/Area/Circumference Measurements

If you option-click again, you will see the
Volume/Area/Circumference icon. You may also pick this icon
from the upper right palette.

1. Click on the object with this tool and it calcu-
lates automatically:
• If the object is a closed surface, you will get the volume and
surface area. 
OR
• If the object is open, you will get the area and circumfe-
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rence. 

2. Click a second point to fix the location of the
measurement.

Repositioning a measurement

1. Pick the Hand icon from the upper right palette.
You must have some measurements displayed on the screen.

2. Click near the measurement you want to reposi-
tion.
It becomes attached to the cursor and follows its moving.

3. Click to define the new location of the displa-
ced measurement.

Deleting a measurement

1. Pick the Lightning icon from the upper right
palette.
You must have some measurements displayed on the screen.

2. Click near the measurement you want to
delete.
It disappears and is removed from the measurements attached
to the current drawing.

3. If you make a mistake, hit Command-Z or
choose Undo from the Edit Menu. 

Deleting all measurements

If you want to erase all measurements displayed on the
screen:

1. Click the Black Hole icon in the upper right
palette.
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All measurements disappear and are removed from the current
drawing.

2. If you make a mistake, hit Command-Z or
choose Undo from the Edit Menu. 

Measurements are persistent, as long as any
modifications made to the relevant elements

do not change the overall shape of the
objects. Otherwise, a message informs you

that it is impossible to retain these measure-
ments.

The measurements are saved with the model
and may be retrieved in a later session.

Get Info...

Use the Get Info command if you want to see and / or modify
informations about the current object .

1 Click the object of interest with the Wand cur-
sor.

2 Choose Get Info.

 

Area: 684,29 cm 2
Volume: 1043,99 cm 3

-45,71 °

16,72 cm

16,51 cm
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The following information is displayed :
• Name of the object : click the name of the object and type a
new name, if you like Hit Return when you are finished typing.
• Object type : volume (closed surface), surface, open or clo-
sed curve, group of elements.
• Number of points, edges, and facets.
• Maximum size in X, Y, and Z.
• Range of Smoothing (Click Suppress to remove the applied
Smoothing).
• Number of filleted edges (Click Suppress to remove the fille-
ted edges).
• Number of curved facets (Click Triangulate to divide them
into flat triangles).
• Number of facets that have more than 4 points (Click
Triangulate to divide them into triangles).
• Number of Mixed points and Defective facets (Click
Suppress to get rid of Mixed or Confused points and Defective
facets).
• NURBS description (click suppress if you want to remove
them, e.g. to make the model polygonal).
• Normal modifications (click on this button to show / modify
normal vector of facets).

3 When you are ready, click OK to accept any
changes you have made or Cancel to return to
defaults.
The dialog box is dismissed and you can continue working.

Viewing / Modifying the normal of facets

Normal of facets determines how a facet is oriented, either out-
wards or inwards. Normally, facets of a model are outwards. If you
want to visualize or change any facet orientation, use this tool :

1. Click the object of interest with the Wand cursor.

2. Choose Get Info.
The information dialog is displayed.
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3. Click on «modify normal».
A Hand cursor appears.

4. Hit the Return key to inverse all the facets of
the model.
You come back to the Information dialog. Click OK to accept
the modification.
OR 

Click on a facet of the model.
A line showing its orientation is displayed. You may use arrow
keys to move around the model and visualize this line from any
view angle.

5. Hit the Space bar to toggle the direction of the
normal (e.g. the orientation of the facet).

6. Click another facet you want to see or inverse
and repeat step 5 if necessary.
OR

Put-aside the cursor to come back to the informa-
tion dialog. Click OK to accept the normal modifi-
cation.
OR

Hit Return key to propagate the facet orientation
to all the others (e.g. to orient all the facets of
the model like the choosen one).

Print

Use this tool to print or 2D-output the current scene. A print
settings dialog appears, allowing you to choose :

• The size of the output page.
• The margin dimensions.
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• The ratio scale applied.
• The driver of output (Clipboard, Illustrator, Printer, PICT, DXF
2D, HPGL).
• The depth of printing.
• The number of desired copies.
• If you want to export color and color scale informations.
When you have defined the print parameters, click OK to conti-

nue or Cancel to abort printing. 
If you choose to continue, a rectangular page icon representing

the page appears.

Printing the Scene

1. Choose the Print tool. 
A print settings dialog appears.

2. Set the parameters you want to use for printing
and hit OK when ready to continue.
A rectangular page icon representing the page appears.

3. Hit the space bar to toggle between landscape
and portrait orientation. 
Place the center of the page over the center of the geometry
you want to print.

4. Click the mouse button when the center is loca-
ted. 
Move the cursor to expand the size of the page.

5. Click when the geometry you want to include is
within the page boundaries. 
The geometry you include on the page is sized to fit within the
page boundaries.

6. If you are using the Printer driver, the system
printing dialog box brings up.
Depending on the type of printer you have, you are able to spe-
cify printer settings, or cancel printing.
OR
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If you have specified a 2D file format (Illustrator, PICT, DXF 2D
or HPGL), the system file saving dialog box appears
Choose a name and a location for the generated file and click
OK or cancel printing.

If you are in axonometric mode, the size of
the printing page icon is automatically adjus-
ted to print according to the specified scale

and current unit. So step 4 of the printing ope-
ration does not exist in this case.

The context in which you choose the Print
command determines the type of output geo-

metry. E.g. to print shapes in hidden lines with
measurements, choose the Hidden lines tool,
followed by the Measurement tool, then finally

choose the Print command.

The End

Click The End to close the current window. You will be asked if
you want to save changes before closing.

1. Click yes to save and quit.

2. Click no to not save and quit.

3. Click cancel to not save and not quit. 
If only one window is open, closing it will quit Amapi.
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The Other Menus
The Tools Menu provides acces to all Amapi’s tools (same

functions as the Amapi graphic icons). Macros and Help menus
offer the opportunity to define macro-commands and to get on-line
help.

The Tools Menu
The Tools Menu contains :

Construction

All the tools of the Amapi Construction toolbox are accessible
here. 

Modeling

All the tools of the Amapi Modeling toolbox are accessible
here. 

Assembly

All the tools of the Amapi Assembly toolbox are accessible
here. 

Utilities

All the tools of the Amapi Control Panel are accessible here. 

Reenter last tool (Cmd-Y)

Choose again the last tool used.

More tools ...

Provides an access to the Extention Toolbox. This additional
Toolbox is rather different. It consists of external tools written in
TCL script, interfaced with AMAPI. It includes all the external tools
contained in the MACROS folder of AMAPI 2.0 Folder. It may, the-
refore, be extended and customized (you may also write your own
interactive tools for AMAPI, with access via this Toolbox). Several
tools are included in this version, both as utilities and examples.
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TESSELATE : Select Tools/More Tools/Tesselate
Useful to divide a facet of an object or a whole object to create

more points to work with (i.e. to select and stretch some points).

You can toggle between Triangle or Quadrangle tesselation.

ORIENT provides a direct access to the faces orienta-
tion tool which can be called using GetInfo tool from
Control Panel and «modify normals» button in the

GetIfo dialog. Please refer to «Viewing / Modifying the normals of
facets» section in Chapter 7 to use this tool.

Close an Object is a generic tool for closing ope-
nings in a shape. E.g. if you have extruded a clo-
sed curve but have forgotten to close the ends
of the solid, they will be displayed in red and
you can close them by clicking near the red
contour (just like in the Extrusion tool). CAP may

be used to close up any gaps (holes, erased faces, etc ...).

General Settings opens the preferences dialog box. 

The Render Menu
The Render Menu contains :

Set Up Render

To define Render main parameters (See Chapter 9 for more
informations).

Shader

To edit a shader for the current selected object  (See Chapter
9 for more informations).
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Set Texture Position

Gives you access to an interactive tool handling the texture
position, scale and orientation.

New Light / New Camera

Adds a light or a camera into the current scene. 

Hide Lights and Cameras

Hides all lights and cameras present in the scene. Allows you
to have a better control of your drawing. This is a toggle. Selecting
again this command will unhide all lights and cameras. 

Viewer

Let you open a real-time viewer window, using QuickDraw 3D
(Mac version) or OpenGL (PC version). You will be able to have a
«solid» view of your models while modeling.

Render Now

Will shade the scene on screen, according to current
Rendering parameters. This enter the same command than pres-
sing the Return key when Toolbox are displayed.

Render Selection

Will shade a selection of the screen.
Click to fix the window center. Then expand the selection win-

dow and click again. Rendering will be performed only inside the
selected area.

Render File

Performs the rendering on a file, allowing you to save a rende-
red picture. You will be able to choose between several file for-
mats (PICT, BMP, TGA) and to choose a location and a file name
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for your image file.

The Animation Menu
The Animation Menu contains :

Set Up Animation

You will be able to set the pixel size of the animation result, as
well as the specific parameters for each platform (AVI settings for
PC and QuickTime settings for the Macintosh).

Assign a Path

Assign a path to the current selected object  (See Chapter 10
for more informations).

Key Framer

Open the KeyFramer tool for the current selected object  (See
Chapter 10 for more informations).

Play animation

Plays the current animation in wireframe mode, allowing you to
have a quick preview of your animation.

Play on file

Plays the animation and records it into a movie file (AVI or
QuickTime), according to the Animation settings.

View animation

Open an animation player, allowing you to view a recorded ani-
mation file. Choose an AVI file for PC platform and a QuickTime
movie for the Macintosh.
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The Macros Menu
This menu allows you to use the command oriented interface

of Amapi.

Shortcut Editor
«Shortcut Editor» let you access another way to the BINDED

tool (see page 8-4 above)

Shortcut Delete
«Shortcut Delet» allows you to remove the function you asso-

ciated with a keyboard key using the Shortcut Editor.

Open Macro
«Open macro» is used to open an existing macro (sequence

file).

Macros
Gives access to a list of external macros:

CUT BY PLANE is a tool combining Cut and 3D Line
Extraction, creating cross-sections in a solid.
Specify the starting point for the cut, then a second

point for the end of the cut. Finally, enter the distance between 2
successive cuts.

ADD A POINT TO CURVE allows you to create a
point in the middle of a segment of a curve. Select
the curve in which you want to add a point, then

select this tool. Simply click on the segment you want to divide.
Repeat the operation if wanted or leave the tool by putting-aside
the cursor.

CONE is a macro command combining extrusion and
smoothing. It automatically creates a conic shape,
with specified number of slices, height and base
radius.
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CYLINDER operates in the same way to produce a
vertically-extruded cylinder.

HELICO is a tool for creating a helicoidal curve
automatically from the current curve. Before using
this tool, you must have a curve as current selec-
ted object (draw a circle for a regular helico). Then

choose this tool and begin by selecting the starting point on the
current curve, then the second point. If the second point is in a
vertical line with the first, and the current curve is a circle, you
will obtain a perfect helix. If the second point is off-center, the
curve will develop in 3 dimensions.It is also possible to start with
a non-circular curve and produce other effects.

INVERT A CURVE allows you the reverse the sense
of the current curve. It may be useful to create
some Coons surfaces ...

OPEN A CURVE will be used if you want to open a
closed curve. Have a closed curve as current
selected object and take this tool. Then click on
the segment you want to remove. This will open

the curve, removing the selected segment.

The Help Menu
Help Level

If you choose «Help Line», you will be drived in all your manipu-
lations by sensitive help icons and by an on-line help. Each time
you will move the cursor on an icon, the help-line (displayed in the
bottom-right corner of the screen), will tell you which tool is asso-
ciated. At any time, the current action will be displayed, as well as
help icons (in a left bottom arc of circle), which will allow you to
access to tools options (+ and - keys, Space Bar and Option-click
actions), in a graphical way.
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If you are not familiar with the Amapi interface, it is highly
recommended to enable the «Help Line» option. 

The Toolbar Menu
Render / Modeling

This will allow you to toggle between Modeling Toolboxes and
Render / Animation Toolbox. You can also press the Space Bar to
toggle the current ToolBox (See Chapter 1 - The Toolboxes)

Utilities

will open the Control Panel as well as if you sweep the cursor
of the bottomest right icon.

View

will open an additional 3-icons palette on the bottom of the
screen, containing interactive icons to handle your displacement
in the workspace
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CHAPTER

9

Rendering Tools

(Studio version only)

The Render Set Up

Edit a shader

The Shader Screen

Texture Parameters Tuning

Rendering, Camera

& Lights controls



Render Set up

Open Render/Set up render menu command.

Camera

Amapi view (default).
You can select camera 0 or camera 1 view (if 1 or 2 cameras
are defined in the scene) and you will see the scene trough
with the selected camera in the real-time viewer as well as for
image calculation, both for rendering and animation.

Quick checkbox

If selected you will obtain a fast rendering without shadows
and textures.
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Auto Smooth

By default, Amapi creates a smooth shading between faces.
The angle parameter is the angle under which two connected
faces will be smoothed. You may either de-activate the autos-
mooth option, as well as you can modify the auto smoothing
angle (0 will produce always flat render, 180 will smooth all
edges of rendered shapes)

Anti-aliasing 

Anti-aliasing will help smooth jagged edges.
You can choose between a value of 0 (no anto-aliasing perfor-
med) and a maximum value of 4.
The use of Anti-aliasing when rendering is time consuming.

Background color

You can select a Background color with the color selector.

Visual step

The rendered scene is displayed using raw pixels (default=
20). If your computer has low RAM capacity, select 3 or 4.

Render file : width and height

Enter the pixel size of next rendered picture.

Edit a shader for the current object

Open Render/Shader menu command to edit a shader for the
current selected object.

Definitions

The object appearance is defined by 3 main parameters:
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• Ambiant component.
• Diffuse component.
• Specular component.

Ambiant component

Is the same on each point of the object, regardless of the
lights. It helps to reveal dark objects on dark backgrounds, or
to raise the overall luminosity or hue of the whole object. Don’t
set it with too high, or the object will be “burned”.

Diffuse component

Is added by each light that lit the object, producing a soft
shade and a “self-shadow” (as the moon is only lit on one side
by the sun). If you turn the object around, the shade stays the
same.

Specular component

Produces highlights on objects, specular component stands for
“the reflection of the lights on a shiny object”: metallic or plas-
tic objets have a high specular component. Diffuse materials
(paper, raw wood) have a very small specular component.
As specular stands for the light’s reflection on the object, that
highlight will move when you move around the object (assu-
ming the light doesn’t move).

These 3 components are added together to produce the final
color of the object.
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The Shader screen

Texture basic parameters tuning:

Material

Select the kind of texture you want to work with (for the current
object).

Current object preview

Interactive tuning window.

Save shader button

Click on it to save the new texture name (after creating it)on
the hard disk.
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Duplishader button

Copy the current shader and add a number after the name (i.e.
to modify it).

Operation on texture 

• Rotate current layer.
You can select to rotate the current layer on X only, Y 
only, Z only or XYZ together.

• Translate current layer.
You can select to rotate the current layer on X only, Y 
only, Z only or XYZ together.

• Scale current layer.
You can select to rotate the current layer on X only, Y 
only, Z only or XYZ together.

Color components

Each of the 3 components illustrated below has a specific
color which can be edited (just click on the color square), and
a slider to adjust the component value.

Remember: the Diffuse Color is the main color of the object.
Usually, the Specular Color is white and the Ambiant Color is
rather dark.

• Ambiant slider : edit the Ambiant value
• Diffuse slider : edit the Diffuse value
• Specular slider : edit the Specular value
• Spread: Controls the wideness of the specular on the

surface: a low value gives a very wide highlight, and a high
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value gives a very tight highlight.

• Falloff: Special control to reduce the highlight wide-
ness: the higher the value, the less wide the hoghlight is (set
it to 0 to disable it). It is used with low values of spread (wide
highlights) to reduce them but keep their shape.

Example: to obtain a nice metal, use low spread and
the falloff: you get a dense highlight and control its wideness
with the falloff.

• Filter: Used to control the influence of the lamp color
on the specular color.

If the filter is set to 0, the color selected for the specu-
lar is ignored: the specular highlight will be the one of the lamp
color. Otherwise, if the filter is set with this higher value, the
specular highlight will be its own color. You can mix the lamp
and specular colors within these limits.

Example: a yellow brass cup will have a yellow highlight
(Specular), even if the light is blue. Usually, metals have the
same specular highlights than their main color (Diffuse).

So, use a high filter for metals ; for plastics use a filter
value 0: a yellow light gives a yellow highlight, even on a blue
plastic box.

• Transparency: Allows transparency to the objects 
A white color means the object is not transparent

(default)
A black color means the object is fully transparent (you

will not see it in the scene).
You can edit the transparency color (just click on the

color square), and use the slider to adjust the transparency
level. The use of transparency is time consuming.

All of these parameters allows you to design basic shaders
with monotone colors.
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The right hand screen (texture layers tuning)

Layer checkbox

Enable-Disable the layers parameters.

Layers

• Add button: You can add a new colormap layer. Do it
before modifying anything, otherwise you are alterating the cur-
rent layer.

• Delete button: Used to delete the current layer.
• Copy button: Used to make a copy of the current layer.
• Paste button: Used to paste the copied layer on the

current layer.

Texture

• Marble: Strata of colors (like stacks).
• Wood: Concentric rings of colors.
• Checker: 2 colors alternated squares. 
• Straight ramp: 3D repeating gradation between colors.
• Smooth Straight ramp: The same without discontinuity.
• Radial ramp: Radial repeating gradation between

colors.
• Smooth Radial ramp: The same without discontinuity.
• Noise: 3D noise (chaos in the colors).

Marble Wood Checker Straight Radial Noise

Destination

Left choice
• None: Disable the texture (diffuse color only).
• Color: Apply the texture on the main color (diffuse

color).
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• Ambiant: Applied to Ambiant, it is an easy way to mix
textures layers: one for the color, one for the Ambiant.

• Diffuse: Only the red component of the texture is
applied to the diffuse parameter. Only the intensity is affected
(not the object color).

• Specular: The texture is applied on the specular (just
to get a noisy highlight).

• Transparency: The object becomes more or less trans-
parent (smoke, glass,…).

• Bump: Add bumps on the texture.

Right Choice
• Replace: This is the default option: the textures

replace the color of the object. This is the best way to test tex-
tures.

• Mix: The texture is mixed with the color of the object
(more or less, see Amount, below).

• Add: The texture is added to the color of the object.
• Sub: The texture is substracted from the color of the

object.
• Mult: Multiply color component by color component.
• Clearer: Take the texture if it is clearer, otherwise do

nothing.
• Darker: Take the texture if it is darker, otherwise do

nothing.

Amount slider

Controls the amount modification level between a texture and
its destination.

Perturbation slider

(No effects if set to 0) Perturbs the texture (chaos). 

Octaves slider 

(No effects if set to 0) Adds complexity on texture. Try it with
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marble and pertubation (increases the rendering time).

Size slider

Modify texture size.

Check boxes: Color/Colormap

• Color: Simple grading within 2 colors.
• Colormap: The best way to achieve wonderful textures:

you can work with many colors, subtle shades visibles on the
objects.

The colormap is designed by interpolation between
colors. Each color can be modified or moved along the color-
map window. The colors interpolation can also be controlled by
a menu. The easiest way to start is to choose an existing
colormap in the first menu (left hand screen: Material window).

Colormap

The colormap is  a color ramp with a second black and white
ramp below. This black and white ramp is the “filter” which
allows you to mix the colors.

Option window (Presetted colormaps)

You can choose between: Fire, Classical, Miami, Toronto, Crazy
cow.

• Copy button: you copy the colormap in a special buffer.
• Paste button: you could paste it later.
• Filter slider: This is the Colormap filter ramp (see

below).

Interpolation window

• Linear: Means linear degrade between colors stripes.
• None: Means colors stripes without degrade.
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Colormap ramp

Select the “Blue marble” texture in the first menu (left hand
screen: Material window). On the Colormap ramp, you will see
a blue degrade color.

Above this ramp there are small square black buttons. One is
red: it is the current one, and to modify its color you have to
click on the blue square above.
Now, a color palette appears and you can adjust the color you
want. 
2 possibilities: HLS or RVB tuning (i.e. choose yellow).

When done, click on the OK button and the main screen
appears, now you can see the new color in the Colormap ramp
and the effect on the current object preview.

To add a new color button, just click on the Colormap ramp
where you want add a new color (i.e. between 2 existing
colors).

Under the Colormap ramp, there is a small square black cross
hatched button: it is the Kill button. When clicking on it, you
kill the current (red) color button.

Between the Colormap ramp and the Kill button, there is  the
filter (black and white ramp): it shows the filter ramp.
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Rendering, Camera & Lights controls

How to render a scene     

• 1st method: Press the Enter key of the keyboard and
the rendering works with the current view of the scene and
default lights.

• 2nd method: With the current scene :
1.Open Render/Viewer/GLViewer or QuickDraw 3D Viewer (if
not displayed).
2.Press the space bar to access to the Rendering and
Animation tools.
3.Place one or more lights and adjust them, (feedback in the
Viewer window is near real time).
4.Create a camera and open Render/Set up render
5.In the Render Set up window, under camera, select camera
view instead of Amapi view.
6.Choose options like Shadows, 3D textures, anti aliasing
level, back color.
7.In the Viewer window you will see the scene through the
camera lens. When ajusting the camera, the real-time viewer
will show the new sight.
8.When the scene is ready, press the Enter key.

Alternate methods: You can work within the 2 previous
methods by placing lights, or not placing cameras or Amapi
view.

How to adjust the current light

1 Take the stretch tool ; control points (white) appear on the
light-object.
2.Rescale, modify the distance and falloff of the light.
3.You can see a preview in the real-time viewer.
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How to adjust the current camera

1. Open Render/Set up render
2. In the Render Set up win-
dow, under camera select camera
view instead of Amapi view.
3. Select the stretch tool, the
control points (white) appear on
the camera.
4. Click-drag the control points
to rescale, modify the distance

and falloff of the camera.
5.You can see a preview in the real-time viewer.

Drag & Drop Textures

1. To open the shaders
catalog, press the space
bar (you will see the
Rendering and Animation
tools).
2. Click on the Shaders
icon.
3. In the shaders cata-
log, you only have to select

a texture, pick it by clicking on it, hold down the mouse button.
Select an object in the scene by browsing the icon of the tex-
ture over it (the object is then displayed in white when adres-
sed with the texture).
4.Release the mouse button to assign the texture to the
object.
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CHAPTER

10

The Animation Tools

(Studio version only)

The Key Framer

Assign a path to an object

Record your animation



The KeyFramer

You will edit

 

Key Frames, e.g. key positions or appearances you
want your model to follow throughout the time.
Editing keyframes means that you will apply deformations on
your model (move it to a different location, modify its scale,
pull vertices or bend it) and you will define at which time this
new appearance of your model will be displayed. Between two
key frames, the Key Framer will make a linear interpolation to
compute all intermediary steps of the shape of your model,
building this way an animation.

Opening the key framer

1. Toggle the current ToolBox by pressing the Space Bar, or by
choosing Render/Animation in the ToolBars menu

2. Click on the Key Framer icon 

OR
Choose the KeyFramer command in the Animation menu.

The Object time line

It represents the evolution of your object throughout the time,
showing you small previews of the key frames and of some
intermediary steps.
The first time you open the Key Framer with an object, only the
first Time Line box (Frame) is displayed, with the current
appearance of your object.
You will store the modified object in empty boxes to build the
animation key frames sequence. But we will explain it in detail
below.

The Object time line also contains a Trash icon, which will
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allow you to delete key frames, a page number selection box,
as well as a slider which is useful to browse the Time Line
pages (like the Catalog).

Control commands

The Space Bar, which will allow you to display subsequently and
cyclically all key frames.
The + / - keys with which you can play the animation step by
step, or just visualize the next or previous frame.

How to build an animation

1. Open the Key Framer with a current object selected.
You see the Object Time Line with only the first box showing a
small preview of the object.
The current appearance of your object is now recorded as the
first frame of your animation.

2. Leave the KeyFramer Tool

3. Take any deformation tool and apply some manipulation on
your object
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4. Open the Key Framer again.

5. Click inside an empty box
The current appearence of your object is recorded as a new

key frame (with the frame number you choose before and
which is displayed in the Frame Number Edition box), and inter-
mediary steps are computed and displayed in the intermediate
boxes.

6. Repeat steps 2 to 5 to complete your animation steps
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How to preview your animation

Once you have recorded at least 2 key frames, pressing the
Return key will play the animation between the first and the
last defined frame.

You may interrupt the animation by pressing the ESC key.
You may also move around the scene as well as in the mode-
ling context, by using the arrow keys or numeric key pad.

Quickly view your key frames

By pressing the Space Bar, you Toggle cyclically bewteen all
defined key frames.

Play your animation step by step

From the current edited frame, by pressing the + or - keys, you
can select respectively the next or previous frame and display
it onto the screen.
It allows you to play your animation frame by frame, as well as
go to a specific frame to edit it.

How to modify an existing frame

 

1. Press the Tab key (or click inside the frame number edition
box)

The Page Number is being edited.
2. Type in the number of the frame you want to edit (modify)
and press Return.

The selected frame is displayed.

OR

1. Click in a full box (where a small preview is displayed) and
drag it into the scene

The current object takes now the appearance of the object
recorded at the frame you took.

3. Leave the Key Framer
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4. Use any deformation tool to modify the shape of the object
5. Go back to the Key Framer
6. Click on the modified object in the scene

A small preview appears under the cursor
7. Click onto the full box you have taken before.

The new object is recorded, replacing the modified key, and
all intermediary steps are updated.

How to delete an existing key frame

You may want to delete an existing key frame (you cannot
delete an intermediary frame, since they are generated auto-
matically).

To do so, simply drag and drop the content of the key frame to
be deleted into the Trash Icon.

How to move a key frame

We mean by “moving a key frame”, giving a specified key
frame a new number, so the corresponding appearance of the
object will be displayed at a different time.

To do this, simply edit the number of the key frame which is
displayed on the top of the key frame. The edited key frame
will automztically be moved into the corresponding box.

How to change the current Object time line page

Use the Slider located on the left side of the Object Time Line
box and browse to display the desired page.

Assign a path to an object

How to assign a path to an object

1. Have a current object selected.
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2. Choose Assign a Path command in the Animation menu
OR

2. Toggle current tool palette by pressing the Space
Bar or selecting Render / Animation in the Toolbars
menu
and click on the Animation Path Icon

3. If you have an already drawn curve in your scene, you can
click on it to select it as the desired path.

If you want to draw the path of the object by hand, click on the
object itself. You are now in the Bezier curve construction tool.
Build the curve and leave the tool as usual.

The selected curve or the drawn curve is now assigned as the
animation path of the currently selected object.

Two things will happen :
• The current object will be snapped to the first point of

the curve (first frame of path animation).
• The curve will be “tesselated” so its number of points

will be the number of desired animation frames (50 by default).

How to choose a different reference point

By default, the reference point which is snapped to the first
point of the path is the Geometric Center of the object.

With the right button of the mouse (Option-Click on the Mac),
you get the Cross cursor. Click any other point in the scene,
which will be used as the reference point for object displace-
ment along the curve.

How to choose the object orientation on the path

By default, the X axis is aligned on the segments of the Path.

By pressing the Space Bar, you can toggle this default axis
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cyclically : X axis, Y axis, Z axis, no orientation. The last
choice means that the object will not be rotated during the ani-
mation along the path.

You can also choose a target point that your object will follow
during the animation (very useful for example to target a
camera on an object). 

Click on the Eye icon. You get the bull’s-eye cursor.
Select an object. The center of geometry of this object
will be the target point for the animated object.

How to choose the number of frames associated with
the path

Press the Edit key. You get a dialog box in which you can type
in the number of frames you want to associate to the Path ani-
mation.

How to save your animation and play it

When finished, you can save your animation in the catalog, like
an object.

To play it again, take it from the catalog and
click on the Play  icon in the Render / Animation
palette

Play on File

To create a rendered movie, you must first give a path to your
object or create key frames.
Then select Animation/Play on File. The file manager will ask
the movie name and a rendering window appears and displays
the picture while calculating.
Animation file is recorded as an AVI file on the PC version and
as a QuickTime movie for the Mac version.

You can stop the calculation process by pressing on ESC key.
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Animation settings window

Saving in a file dialog box

Animating parameters dialog box

10-9



10-10



INDEX

A

Aliasing 9-5; 9-15; 9-16
Ambient 9-15
Arc tool 3-17; 4-9
Arrow keys 1-6; 1-21
Assembly 1-16; 6-3
Association 7-4; 9-4

B

Back view 1-7
Background color 9-5
Backup 3-5
Bend 3-23; 5-9
Bézier Curve 3-16; 4-7
Black Hole 1-20; 2-4
Bulb 9-6
Bull’s-eye 1-14
Bump 9-13

C

Cancel 1-19
Catalog 2-3
Center 1-13
Circle 3-16; 4-5
Clear 1-21
Close 3-4; 4-7; 4-21
Color 1-6; 7-13; 9-4
Construction 1-15; 3-16; 4-4
Control Key 1-6
Control Panel 1-16; 7-4
Control Polygon 3-22
Copy 1-7; 2-6; 3-9; 6-10
Create 1-17; 3-3; 8-6; 9-4

Cube 3-18; 4-17
Cursors 1-12
Curve Extract 3-20; 4-29
Curves 1-3; 1-18
Cut 3-9; 3-23; 5-13

D

Define Catalog 2-7
Delete 1-12; 1-20; 3-10; 3-23; 5-11
Diffuse 9-12
Disintegrator Gun 1-20; 7-11
Duplicate 1-7; 3-9; 6-10

E

Edit 3-9; 9-6; 9-10
Erasing 1-19; 2-4
EPSF 3-13
Export 2-11

F

Fast Shade 7-12
File 2-3; 3-3
Fillet 3-24; 5-24
Fixed point 5-18
Flood light 9-6
Focal angle 9-17
Front view 1-7

G

Get Info 7-19
Grid 1-4; 3-18; 4-18
Group 1-11; 7-4

H

Hide 7-6
Hull surface 4-26



I

Image Preview 9-9
Import 2-10
Inverse normal 7-20
Isometric View 7-10

K

Keyboard shortcuts 1-6

L

Lasso 1-13
Lay on 6-7
Left View 1-7
Lights 8-6; 9-3
Lock 1-11

M

Measures 7-15
Memory 3-12
Merge 2-7; 3-3
Mirror 3-17; 4-14; 6-13
Modeling 1-15; 5-3
Mold 3-23; 5-8
Move 6-4

N

Name 1-10
New 3-3
Number pad 1-7
NURBS 3-15; 4-12

O

Object 9-14
Open 3-3
Option key 1-12

P

Paint 7-12
Pan 1-6
Paste 3-10
Patterns 9-11
Perspective 7-10
Phantom 7-6
PICT 2-10; 3-12
Planes 1-5
Polyhedral Modeling 1-3
Polylines 4-6
Preferences 3-11
Preview 9-9
Print 3-8; 7-21
Proportional Scale 5-18
Punch 5-14
Put-aside 1-17

Q

Quit 3-8

R

Rectangle 3-17; 4-11
Rectangular surface 3-18; 4-18
Reflection 9-12
Return key 1-9
Right View 1-7
Rotate 1-6; 6-5
Ruled Surface 3-20; 4-25

S

Save 2-8; 3-4
Scale 3-147; 5-18; 7-21; 9-13
Scroll 2-5
Select 1-9; 1-13; 3-10



Shadows 9-17
Shift Key 1-10
Show 7-5
Single Axis Scale 5-19
Smooth Shade 9-3
Smooth Tool 3-24; 5-20
Snap 1-10; 6-6
Space Bar 1-11
Sphere 3-18; 4-15
Spot 9-6
Stretch 3-22; 5-4
Sun 9-6
Surface Extract 4-32
Sweep 4-22

T

Tab Key 1-10
Texture Catalog 9-7
Thickness 4-35
ToolBoxes 1-15
Top View 1-7
Transparency 9-12

U

Undo 1-12; 1-19; 3-9; 3-12
Unfold 6-15
Ungroup 7-4
Units 3-12
Utilities 8-3

V

Validate 1-16
View Point 7-14
Views 1-5

W

Weld 6-8
Workbench 1-4

Working Plane 7-10
World button 9-16

Z

Zoom 1-7; 7-14; 7-15
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